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About This Guide

The IBM® WebSphere® Business Integration (WBI) Monitor™ Deployment guide will guide
you through the steps for deploying WBI Monitor. It also provides a technical background
about the WBI Monitor client-server architecture.

Introduction: Provides an introduction to the WBI Monitor architecture and a description of
the steps necessary to deploy the WBI Monitor in order to use it for monitoring business
processes.

Part 1 IBM WBI Monitor Architecture and Requirements

Chapter 1: WBI Monitor Architecture is intended for technical IT personnel interested in
learning about the client-server architecture of the WBI Monitor. In this chapter, you learn
about the WBI Monitor's main components, their communications flows and their
communications with other related applications.

Chapter 2: Necessary Requirements before Deployment lists the needed Hardware,
Software and System requirements in order to deploy WBI Monitor.

Part 2 IBM WBI Monitor Deployment on Windows, AIX® and Solaris Platforms

Chapter 1: Database Configuration describes the general steps for creating the Monitor
database and configuring both the Monitor and EventQueue databases.

Chapter 2: WBI Monitor Deployment on Windows, AIX and Solaris Platforms describes the
steps for deploying WBI Monitor on IBM WebSphere Application Server automatically using
the automated deployment wizard on Windows, AIX and Solaris platforms.

Appendix A: Manual Deployment of WBI Monitor on WebSphere 4.0.2 describes the manual
steps of deploying WBI Monitor on IBM WebSphere 4.0.2.

Appendix B: Manual Deployment of WBI Monitor on WebSphere 5.0 Describes the manual
steps of deploying WBI Monitor on IBM WebSphere 5.0 for both editions Application Server
and Network Deployment.

Appendix C: IBM DB2® 7.2 Database Server Configuration describes the detailed steps for
creating the Monitor database and configuring both the Monitor and EventQueue databases
on IBM DB2 Universal Database™ v7.2 as an example of the Database configuration’s
detailed steps.

Appendix D: Controlling the Logging Service in IBM WBI Monitor v4.2.4 describes the
detailed steps for controlling the logging service and setting the debugging level in order to
determine the message types that should be recorded in the log files.

Part 3 IBM WBI Monitor Deployment on 0S/390® and z/OS™ Platforms

© Copyright IBM Corp. 2002, 2003 1



Chapter 1: WBI Monitor Deployment on OS/390 and z/OS Platforms describes the steps for
creating the Monitor database and deploying WBI Monitor on IBM WebSphere on OS/390
and z/OS platforms.

Part 4 Upgrading your Existing Version of WBI Monitor to the Recent Version

Chapter 1: Upgrading your Existing Version of WBI Monitor to the Recent Version Describes
the steps required for upgrading your existing version of WBI Monitor to the recent version

Glossary: Includes detailed definitions of the terms mentioned in this guide.
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Introduction

Efficient business process management and continuous process improvement
require managers to monitor their business processes regularly. Competitive
pressures require management to effectively identify and rigorously assess
process changes that are needed to meet the demands of market changes.
Assessment of the effectiveness of changes in business strategies requires
monitoring of business processes.

The WBI Monitor has been built to fulfill these requirements. WBI Monitor is a
Java-based and Web-based client/server application that allows operation on
virtually any platform. The following sections give a brief introduction to the WBI
Monitor architecture and a description of the steps necessary to deploy the WBI
Monitor in order to use it for monitoring business processes.
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Chapter 1: WBI Monitor Architecture

The WBI Monitor consists of the Monitor Server, which is hosted on an
application server such as IBM WebSphere, and the following four distinct user
clients:

- Administration Utility
- Workflow Dashboard
- Business Dashboard
- Notifications
- Monitor Portlets
The Monitor Server consists of the following six modules:
- Client Agent EJB
- Monitor Engine
- Monitor Service
- Monitor Web Application
- Monitor Data Model
- Monitor API

The Monitor Server communicates with IBM MQSeries® Workflow, IBM
WebSphere MQ Integrator (WMQI) (or IBM WBI Message Broker), and IBM
WebSphere InterChange Server (WICS) through the Event Collector Triggers.
Those triggers are installed on the MQSeries Workflow runtime database in
case of using the MQSeries Workflow as the engine, or installed on the Monitor
database in case of using WMQI or WICS as the engine. These triggers copy
the events with the container data to the Monitor Event Queue tables. The data
in the tables stay in the database waiting for processing by the Monitor Engine.
The Monitor Server polls those tables to retrieve, process, and finally delete
these events from the Monitor Event Queue tables when processing is done.

© Copyright IBM Corp. 2002, 2003 7
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Monitor Server

The server works behind the scene to handle all the operations of the four user
clients. As mentioned before, it consists of six components:

- Client Agent EJB
- Monitor Engine
- Monitor Service
- Monitor Web Application
- Monitor Data Model
- Monitor API
These components are responsible for:
- Cleaning up the Monitor database tables
- Providing Data Security

- Importing the XML (modeling data) created in IBM WebSphere
Business Integration (WBI) Workbench™

- Handling the communication with user clients

- Handling the events coming from MQ Workflow, WebSphere MQ
Integrator (WMQI), WebSphere Business Integration Message
Broker, or WebSphere InterChange Server (WICS).

- Encapsulating the SQL statements for data access.

Client Agent EJB

This Session Enterprise Java Beans (EJB) is responsible for administering the
Monitor Server, and the communication between the Monitor Server and the
Monitor Clients. It handles the WBI Monitor database tables cleanup, data
security, and importing the XML file created in WBI Workbench.

Monitor Engine

This module handles events coming from MQ Workflow, WebSphere MQ
Integrator (WMQI), WBI Message Broker or WebSphere InterChange Server
(WICS). The Monitor Engine picks up the events, processes them, and stores
the output in the database for later retrieval by the clients. The processed
events are deleted after processing.

Monitor Service

The Monitor Service runs as a continuously running servlet, to asynchronously
call the Monitor Agent EJB to fetch the MQ Workflow, WMQI and WICS events



and process them. It is loaded at application startup from inside the Bootstrap
servlet.

1.1.4 Monitor web application

The Monitor web application contains all necessary web resources to run the
Monitor clients. These include JSP pages, servlets, HTML pages, images, etc...

1.1.5 Monitor Data Model

The Monitor Data Model is the database access layer of the Monitor Server.
The Monitor server uses Java Database Connectivity (JDBC). All Database
SQL statements are encapsulated in this layer.

1.1.6 Monitor API

The Monitor API is the Application Programming Interface layer of WBI Monitor.
It hides the details of the server implementation, and gives any developer the
capability to develop a customized user interface on top of the Monitor.

WBI Monitor client is actually built on top of this API. It has a published
documentation in the form of Javadoc HTML format. It can be used to:

- Develop customized reports user Interfaces

- Extract data from WBI Monitor, whether current or historical, to be used
in data warehousing for example.

- Access WBI Monitor Administrative functions

10 IBM WBI Monitor - Deployment Guide



1.2 WBI Monitor Administration Tools

The WBI Monitor Administration Tools allow users to perform all the necessary
steps to import the modeled business processes with their associated Business
Measures. It also provides the capability to maintain the Event Queue and
Monitor Database through managing the creation and dropping of these
databases’ tables, starting and stopping the event queue triggers, and cleaning
up unnecessary data.

1.2.1 WBI Monitor Administration Utility

The WBI Monitor Administration Client is a Web-based client that allows users
to do the following:

- Stop/restart the Event Queue triggers and create / Drop the Monitor
and Event Queue database tables.

- Import WBI Workbench's XML files that contain the organizations and
their processes and the Business Measures defined in WBI
Workbench.

- Delete the unnecessary process instances and history data that were
stored cumulatively in the monitor database after monitoring business
processes. This enables users to automatically clean up the WBI
Monitor database periodically as specified by a user-defined interval.

© Copyright IBM Corp. 2002, 2003 11



1.3 Monitor User Clients

The Monitor User Clients allow users to monitor the modeled business
processes and their associated Business Measures.

1.3.1 Workflow Dashboard

The Workflow Dashboard is an HTML-based client that allows users to monitor
the business processes at run time. The Workflow Dashboard allows users to
view the:

* Built-in and user-defined Business Measures.

« Status of Process, Activity, Work Item, and Employee Instances for the
whole Organization or for a particular Organization Unit.

1.3.2 Business Dashboard

The Business Dashboard is an HTML-based client that allows users to retrieve
and view the historical data of the monitored business processes and to view
and keep track of aggregated historical business measures.

1.3.3 Notifications

The Notifications is an HTML-based client that allows users to view all
notifications sent from process instances of a process at run time. A notification
is created and sent to specific user(s) according to the result of evaluating a
specific Boolean business measure.

1.3.4 Monitor Portlets

There are four WBI Monitor Portlets:
» Workflow Dashboard Portlet.
* Business Dashboard Portlet.
* Notification Portlet.

* Process Diagram Portlet.
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Chapter 2: Necessary Requirements
before Deployment

The following chapter describes the requirements for deploying the WBI
Monitor. It lists the hardware, system, and software requirements for the
Monitor Server and Web Clients.

© Copyright IBM Corp. 2002, 2003
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2.1 Monitor Server Requirements

2.1.1 Hardware Requirements

2.1.1.1 Windows Server

- Pentium Il 650 MHz or higher

- 512 MB RAM or higher (1 GB RAM recommended)

- 50 MB Disk space, in addition to sufficient disk space for database
2.1.1.2 AIX Server

- IBM RS/6000®
- 1 GB RAM or higher

- 50 MB Disk space, in addition to sufficient disk space for database.

2.1.1.3 Solaris Server

- Sun server machine
- 1 GB RAM, or higher

- 50 MB Disk space, in addition to sufficient space for database.

2.1.1.4 z/OS or s/390 Server

- IBM zSeries 900 or S/390 system
- 1 GB RAM, or higher

- 50 MB disk space, plus sufficient space for database

2.1.2 System Requirements

2.1.2.1 Windows Server

- MS-Windows NT 4.0 (with Service Pack 4 or Higher) or MS-Windows
2000 Server

2.1.2.2 AIX Server
- AlX 4.3.3 or AIX 5.1 or later

2.1.2.3 Solaris Server

- Solaris 8, maintenance level August 2001 or later

14 IBM WBI Monitor - Deployment Guide



2.1.2.4 z/OS or s/390 Server
- OS/390 Version 2.8, Version 2.9, Version 2.10, or

- z/OS Version 1.1 or Version 1.2

2.1.3 Software Requirements

2.1.3.1 Windows, AIX, and Solaris Platforms

- IBM DB2 Universal Database version 7.2 with Fixpack 5 or higher, or
IBM DB2 UDB V8.1

- Oracle 8i Database Server release 8.1.7.1 or Oracle 9i Database
Server release 9.0.1

- IBM WebSphere Application Server 4.0.2 Advanced Edition.Or
- IBM WebSphere Application Server v5.0 fixpack 1. Or

- IBM WebSphere Deployment Manager (Network Deployment) v5.0
fixpack 1.

- IBM MQSeries® Workflow 3.3.2 or IBM WebSphere MQ Workflow V3.4

- IBM MQSeries Workflow 3.3.2 Web Client or IBM WebSphere MQ
Workflow V3.4 Web Client.

- IBM WebSphere MQ Integrator (WMQI) v2.1 or IBM WBI Message
Broker v5.0

* For WMQI v2.1:
- WMQI v2.1 CSD 6, or
- WMQI v2.1 CSD 5 with fix for APAR PQ77984, or
- WMQI v2.1 CSD 4 with fix for APAR PQ77984
* For WBI Message Broker v5.0:
- WBI Message Broker v5.0 CSD 1 (CSD 2 recommended).

[z%_| To monitor WebSphere Business Integration Message Broker and

¥ WebSphere MQ Integrator Broker event flows, the WebSphere
Business Integration Message Broker MonitorEmitter node
SupportPac is required. This SupportPac can be downloaded free
of charge at: http://www.ibm.com/webspheremq/supportpacs

- IBM WebSphere InterChange Server 4.2.2.1 Fix Pack.
- IBM WebSphere Portal Enable 4.2.0

- Java-enabled browser (IE 5.5 or higher).

© Copyright IBM Corp. 2002, 2003 15
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2.1.3.2 z/OS and 0S/390 Platforms

- IBM DB2 Universal Database for OS/390, Version 7.1 or higher
- IBM WebSphere Application Server V4.0.1 for z/OS and OS/390

- IBM MQSeries Workflow V3.3.2 SP3 or IBM WebSphere MQ Workflow
V3.4

- IBM MQSeries Workflow 3.3.2 Web Client or IBM WebSphere MQ
Workflow V3.4 Web Client.

- IBM WebSphere MQ Integrator (WMQI) v2.1.0 for z/OS:
* WMQI v2.1 CSD 6, or
* WMQI v2.1 CSD 5 with fix for APAR PQ77984, or
* WMQI v2.1 CSD 4 with fix for APAR PQ77984

To monitor WebSphere Business Integration Message Broker and
WebSphere MQ Integrator Broker event flows, the WebSphere
Business Integration Message Broker MonitorEmitter node
SupportPac is required. This SupportPac can be downloaded free
of charge at: http://www.ibm.com/webspheremgq/supportpacs

IBM WBI Monitor - Deployment Guide



2.2 Monitor Clients Requirements

2.2.1 Hardware Requirements

- Pentium 111 650 MHz or higher
- 128 MB RAM or higher (256 MB RAM is recommended)

2.2.2 System Requirements

- Windows 98, Windows NT 4.0, Windows 2000, or Windows XP

2.2.3 Software Requirements

- Java-enabled browser (IE 5.5 or higher)

© Copyright IBM Corp. 2002, 2003
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Chapter 3: Database Server
Configuration

This chapter provides you with the configuration parameters and steps needed
for configuring your database server by creating the Monitor database and
configuring both the Monitor database and the Event Queue database (the IBM
MQSeries Workflow or the IBM WebSphere MQ Workflow database).

The instructions in this chapter assume that you are creating the WBI Monitor
database for the first time. If you have an earlier version of WBI Monitor and
there is an existing Monitor database that already contains data stored in its
tables, then you need to upgrade your database to adhere to the latest
modification in the current version of WBI Monitor 4.2.4 database, and migrate
the stored data to the upgraded database. Please refer to the chapter entitled:
Upgrading your Existing Version of WBI Monitor to the Recent Version for
details about the database migration.

The sections below will guide you through creating and configuring the
databases for IBM DB2 and Oracle database servers using all supported
versions in Windows, AIX and Solaris platforms. Please refer to the IBM DB2
and Oracle documentation for the required steps of creating and configuring the
databases.

You can refer also to Appendix C of this guide for an example of the detailed
steps of creating the Monitor database and configuring both the Monitor
database and the Event Queue database using IBM DB2 7.2 with fixpack 5 on
Windows platform.

© Copyright IBM Corp. 2002, 2003 21



3.1 Configuring IBM DB2

The following sections are for the required parameters for configuring IBM DB2
database for both IBM DB2 7.2 and IBM DB2 8.1 on Windows, AlX and Solaris
platforms:

_ﬁ'}- Make sure that IBM DB2 Server is configured for JDK 1.2 or higher.

3.1.1 Create the Monitor Database

Create a new Database for Monitor. No specific name is required, though IBM
WBI Monitor recommends WFMDB as the Monitor database name.

3.1.2 Configure the Monitor Database

To increase the performance, you should configure the created database by
adjusting the following configuration settings in the Monitor Database with these
values, and then reconnect to the database:

For IBM DB2 7.2

Parameter Name Parameter Value
Location

Maximum Storage for Performance Tab 50000

Lock list

Application Heap Size Performance Tab 4096

Application Control Performance Tab 4096

Heap Size

Maximum Lock per Application Tab 50

application

For IBM DB2 8.1

Parameter Name Parameter Location | Value
LOCKLIST Performance Section 50000
APPLHEAPSZ Performance Section 4096

APP_CTL_HEAP_SZ Performance Section 4096

MAXLOCKS Application Section 50

|75 | You can configure the Monitor database with the above
parameters even if the WBI Monitor is running. In this case you
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have to restart the WBI Monitor in order to use the new database
settings.

3.1.3 Calculate the Page Size

If one of the business processes in the organization file (.org) contains more
than 55 business measures, you should calculate the page size by performing
the following steps:

1. From the .org file, calculate the maximum number of business measures
in any process of the model

Divide the calculated number by 55

Round the result number up to the nearest integral value. (e.g. if the
result is 1.3 then the you should round it up to 2)

Multiply the last value by 4K.

Round the result up to the nearest value of 8K, 16K, 32K, etc. This will
be the required page size. (E.g. if the result is 12K, then the required
page size is 16K)

3.1.4 Create a Buffer Pool

Create one or more Buffer Pools (No specific name is required) to be assigned
to the TableSpaces that will be created in the next step. Set the Page Size of
each of these new Buffer Pools to be equal to the calculated page size you
calculated in the previous step.

25, You must restart the DB2 services or restart the machine in order
B to use the created Buffer Pool.

3.1.5 Create the Required TableSpaces

Create the required TableSpaces in both the Monitor Database (WFMDB) and
the EventQueue Database (FMCDB). WBI Monitor allows you to control the
distribution of the Monitor and the EventQueue Database tables and indices
into a number of TableSpaces that are up to 22 TableSpaces; 19 of them are
created in the Monitor Database and three of them are created in the
EventQueue Database. The database tables and indices are grouped and
categorized so that each category can be assigned to a separate TableSpace.

This number is the maximum number of TableSpaces to which you can assign
the database tables and indices. This means you do not have to create all these
TableSpaces, but you can create part of them. In this case, during the
deployment steps, you can assign more than one group of tables or indices to
the same TableSpace.

© Copyright IBM Corp. 2002, 2003 23
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Please refer to the section named Database Tables and Indexes Allocation with
Multiple TableSpaces below for details about the distribution of the Monitor and
EventQueue database tables and indexes on multiple TableSpaces.

For each created TableSpace, Add a container and specify its name and current
directory.

The page size value of the MQ Workflow database table spaces is not
affected by the number of business measures in the organization file
processes.
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3.2 Configuring Oracle Database

In case you decide to create a Database Instance for WBI Monitor, follow the
coming steps:

1.

Create a new Database Instance for Monitor (No specific name is
required, but IBM WBI Monitor recommends WFMDB as the Monitor
Database Instance name).

Create the required TableSpaces in both the Monitor Database
(WFMDB) and the EventQueue Database (FMCDB). WBI Monitor
allows you to control the distribution of the Monitor and the EventQueue
Database tables and indices into a number of TableSpaces that are up
to 22 TableSpaces; 19 of them are created in the Monitor Database and
three of them are created in the EventQueue Database. The database
tables and indices are grouped and categorized so that each category
can be assigned to a separate TableSpace.

This number is the maximum number of TableSpaces to which you can
assign the database tables and indices. This means you do not have to
create all these TableSpaces, but you can create part of them. In this
case, during the deployment steps, you can assign more than one group
of tables or indices to the same TableSpace.

Please refer to the section named Database Tables and Indexes
Allocation with Multiple TableSpaces below for details about the
distribution of the Monitor and EventQueue database tables and indexes
on multiple TableSpaces.

Make sure that all TableSpaces you use for the Monitor database tables
are auto extendable.

Enable the Java VM on both the WFMDB instance that you have created
as the Monitor database, and the FMCDB database instance (the MQ
Workflow Database), which is usually created by the fmczutil
configuration utility of MQ-Workflow without the Java VM option.

% | You need to enable the Java VM option only if you have two
4 separate database instances for the Monitor database and the

EventQueue database. In case you are using the FMCDB instance
as the Monitor database (Single Instance), then you don’t need to
perform this step.

5. Create a new user that will be used by the WBI Monitor server to access

the Monitor database.

- Make sure that the UNLIMITED TABLESPACE System Privilege is
Granted for this user.

If you decide to use the FMCDB Instance (The MQ Workflow database) as the
Monitor database instance (single instance for both), then the WBI Monitor will
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use the Monitor Connection User (WFM) to access the FMC Schema (the MQ
Workflow database schema) in order to perform the following database actions:

- DDL actions

* CREATE TABLE & DROP TABLE

* CREATE TRIGGER & DROP TRIGGER

* CREATE SEQUENCE & DROP SEQUENCE
- DML actions

* SELECT

* INSERT

* UPDATE

* DELETE

* EXECUTE TYPE
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3.3 Database Tables and Indexes
Allocation with Multiple
TableSpaces

3.3.1 In the Monitor Database (WFMDB):

* Administration tables and indexes can be assigned to Admin data Tables
and Admin Data Indexes TableSpaces respectively. The Monitor database
tables that will be associated with the first TableSpace are:

*

*

*

*

*

SCHEMA_HEADER
CONFIG_DATA
NEXT_ID
SYS_PROPERTIES
AGENTS

QUEUES
EB_SYNC_TABLE
MQ_SYNC_TABLE
WMQI_SYNC_TABLE
ICS_SYNC_TABLE
CLEANUP_SYNC_TABLE
NOTIFY_SYNC_TABLE

The indexes of the tables above will be assigned to the second
TableSpace.

« Static Model Data tables and indexes can be allocated to Static Model data
Tables and Static Model Data Indexes TableSpaces respectively. The
Monitor database tables that will be associated with the first TableSpace

are:

*

*

*

© Copyright IBM Corp.

ORG_UNIT
ORGANIZATION
ROLE_DATA
USER_DATA
PROCESS
PROCESS_MODEL
ACTIVITY
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The indexes of the tables above will be assigned to the second
TableSpace

* Runtime Data tables and indexes can be allocated to Runtime Data Tables
and Runtime Data Indexes TableSpaces respectively. The Monitor
database tables that will be associated with the first TableSpace are:

* PROCESS_INST
* ACTIVITY_INST
* WORK_ITEM

* VARIABLES

* NOTIFY

The indexes of the tables above will be assigned to the second
TableSpace.

* Events Data tables and indexes can be allocated to Events Data Tables
and Events Data Indexes TableSpaces respectively. The Monitor database
tables that will be associated with the first TableSpace are:

* EVENTS

* DELAYED_EVENTS

* MBEVENTS

* CXFLOWEVENTRECORDS

The indexes of the tables above will be assigned to the second
TableSpace.

* Process Data tables and indexes can be allocated to Process Data Tables
and Process Data Indexes TableSpaces respectively. The Monitor
database table that will be associated with the first TableSpace is:

* PROCESS_DATA
The index of the table above will be assigned to the second TableSpace.

* Security tables and indexes can be allocated to Security Tables and
Security Indexes TableSpaces respectively. The Monitor database tables
that will be associated with the first TableSpace are:

* SECGROUP

* SECGRPMEMBER
* SECACTION

* SECSECOBJTYPE
* SECACL

* SECACE

* SECPERMISSION
* SECSECSESSION
* SECUSER
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* SECSECMANAG

* SECPRINCIPAL

* SECSECTYPE

* SECANDORCONSTR
* SECAND

* SECOR

The indexes of the tables above will be assigned to the second
TableSpace.

* Different Large Objects (LOBs) tables can be assigned to several LOB
TableSpaces as in the following:

* Static Model Lob table can be allocated to Static Model Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- PROCESS_MODEL

* Process Data Lob table can be allocated to Process Data Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- PROCESS_DATA

* Configuration Data Lob table can be allocated to Configuration Data
Lob TableSpace. The Monitor database table that will be associated
with this TableSpace is:

- CONFIG_DATA

* Notify Extra Data Lob table can be allocated to Notify Extra Data Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- NOTIFY

* Event Data Lob table can be allocated to Event Data Lob TableSpace.
The Monitor database table that will be associated with this
TableSpace is:

- EVENTS

* Delayed Event Data Lob table can be allocated to Delayed Event Data
Lob TableSpace. The Monitor database table that will be associated
with this TableSpace is:

- DELAYED_EVENTS

* WBI Message Broker Lob table can be allocated to WBI Message
Broker Lob TableSpace. The Monitor database table that will be
associated with this TableSpace is:

- MBEVENTS
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3.3.2 In the MQ Workflow Database (FMCDB):

* MQ Workflow Connector Queue (EventQueue) tables and indexes can be
allocated to EventQueue Tables and EventQueue Indexes TableSpaces
respectively. The database tables that will be associated with the first

TableSpace are:
* HS_AUDIT_TRAIL
* HS_CONT_DETAIL
* HS_PROC_DATA

* HS_SCHEMA
The indexes of the tables above will be assigned to the second
TableSpace.

* MQ Workflow Data Lobs can be allocated to MQWF Data Lobs
TableSpace. The database table that will be associated with this

TableSpace is:
* HS_CONT_DETAIL
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3.4

Using the National Language
Support (NLS)

To serve as many users as possible, WBI Monitor v4.2.4 provides Globalization
features in order to support using multiple languages other than English.

The supported code pages are:

1252 - English 1255 - Hebrew

1252 - French 1256 - Arabic

1252 - German 932 - Japanese

1252 - Italian 936 - Chinese (Traditional)
1252 - Portuguese 950 - Simplified Chinese
1252 - Spanish 949 - Korean

Note: Switching GUI and text direction to Right-to-Left is not
supported in this release.

The support for multiple languages rather than the English language requires
that the WBI Monitor database must be created with UTF-8 code page.

If you have created the monitor database with a different code page (for
example IBM-1252), whether as a new database for the recent version of WBI
Monitor or for any previous version of WBI Monitor, and you need to allow using
multiple languages then you must export all tables of the WBI Monitor schema
(defaults to WFM unless changed) and import these tables into a newly created
database with UTF-8 code page before the database migration. Please consult
your Database Administrator for information about converting the code page of
an existing database.
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Chapter 4: WBI Monitor Installation

This chapter provides a step-by-step procedure that guides you through
Installing IBM WebSphere Business Integration (WBI) Monitor with all its
components and deploying the Monitor Server on Windows, AIX and Solaris
platforms. The chapter also contains the procedures of un-deploying the
Monitor Server and how to completely uninstall WBI Monitor. At this stage, it is
assumed that all the prerequisite software has been installed, and the Monitor
and Event Queue databases have been created and configured successfully.

The following conventions are used for all the instructions throughout this
document:

- <WebSphere> : The WebSphere home directory. e.g. C:\WebSphere

- <MQ> : The MQ Workflow home directory. (For example:
C\WebSphere\AppServer on Windows platform, /usr/WebSphere/
AppServer on AlX platform, or /opt/WebSpherelAppServer in Solaris
platform).

- <DB2> : The DB2 home directory. (For example: CASQLLIB)

- <Oracle> : The Oracle home directory on the Oracle Server machine
(if Oracle is not running on the same machine on which the IBM
WebSphere Application Server is installed). For example:
C:\oracle\ora81 (Local) or \\oracle_machine\oracle\ora81 (Network)

- <Monitor> : The Monitor installation directory. (For example:
CAWBIMonitor)

- <WebServerName> : The name of the machine that hosts the Web
server for which the WebSphere is configured. (For example: The
machine name on which the IBM HTTP Server or Microsoft IIS 4.0 or
[IS 5.0 is installed)

- <ServerName> : The name of the server on which the Monitor will be
installed.

- <WebPath> : The monitor web application web path (For example: /
monitor).

Important Notes:

- On AlX and Solaris platforms, use forward slash / instead of back-slash
\ when writing paths.

- The names and paths of folders and files are case sensitive.

- The names and paths of folders and files that you will specify during
the installation should not contain any spaces. (For example, the
Monitor installation directory, the WebSphere home directory, and/or
the DB2 home directory)
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- Make sure that the user account you are using have all needed
permissions. For example, using a user account who has no
permissions on WebSphere or the Database will fail to install and
deploy the monitor.

- On AIX 5.1 platform, the environment variable named LIBPATH must
be appended with the following paths: <MQ>/lib and <MQ>/lib/
magqserver. To do this, type the following command in the console
window from which you will start the WebSphere and then press Enter:

export LIBPATH=$LIBPATH:<MQ>/lib:<MQ>/lib/mqserver

- The Monitor will not work if the server properties
client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.

If you are using WebSphere Application Server 4.0.5, the property
client.encoding.override=UTF-8 should be added explicitly in the
server JVM's settings. This must be done manually after you finish the
deployment if you performed the deployment automatically using the
WBI Monitor Installation Wizard as in the following steps:

*

*

*

*

Open Administrator's console

Select the Monitor Server from the Application servers
Select the JVM Settings tab

In the System Properties list, click Add

Type client.encoding.override as the property name.
Type UTF-8 as the value.

Click apply and restart the server
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4.1 IBM WBI Monitor Installation
Wizard

The WBI Monitor is installed using the WBI Monitor Installation Wizard. This
wizard allows you to do the following:

* Perform only the manual installation of the WBI Monitor components by
extracting the necessary folders and files that are required for the
installation and deployment.

* Install the WBI Monitor components and perform the automatic
deployment for these components as follows:

* Perform the automatic deployment of the Monitor Server on IBM
WebSphere Application Server 4.0.2 or IBM WebSphere Application
Server 5.0 or IBM WebSphere Deployment Manager 5.0 on Windows,
AIX and Solaris platforms.

* Install the WBI Monitor Portlets on a specific WebSphere Portal
Server.

* Install the LDAP Bridge

The following sections in this chapter describe how to use the WBI Monitor
installation wizard to install these components automatically.

For a description of the manual deployment of Monitor Server on WebSphere
4.0.2, please refer to Appendix A of this guide: Manual Deployment of WBI
Monitor on WebSphere 4.0.2. For a description of the manual deployment of
Monitor Server on WebSphere 5.0, please refer to Appendix B of this guide:
Manual Deployment of WBI Monitor on WebSphere 5.0.

For a description of the manual installation of WBI Monitor Portlets on a
WebSphere Portal Server, please refer to the section entitled Installing WBI
Monitor Portlets in chapter 4 WebSphere Portal Support of the WBI Monitor
User Guide

For a description of how to Control the Logging Service in IBM WBI Monitor,
please refer to Appendix D of this guide: Controlling the Logging Service in IBM
WBI Monitor v4.2.4

4.1.1 Starting the WBI Monitor Installation Wizard

The WBI Monitor Installation Wizard starts by running the jar file named
WBIMonitor424.jar from the product CD or from the location where you have
extracted the contents of the zip file that you downloaded from the Internet.

Before starting the WBI Monitor Installation Wizard, you have to make sure that
an environment variable named WAS_HOME is defined and contains the actual
path of the IBM WebSphere Application Server installation directory. If this
variable is not defined, then you must define it by doing the following:
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* On Windows platform:

1. Open a command line window.

2. Type the following:
WAS_HOME = <WebSphere>
Set WAS_HOME

3. Run the WBIMonitor424.jar from this command line window.

* On AIX or Solaris platforms:

1. Open a Terminal Console using root.

2. Type the following in the command line:
WAS_HOME= <WebSphere>
export WAS_HOME

3. Run the WBIMonitor424.jar from this terminal console.

If you are using IBM DB2 as the database server on AIX and Solaris platforms
only, make sure that you run the Installation wizard with a user who is in the DB2
Administrators group. You should also run at least once the <DB2>/dbZ2profile
file from the same terminal console from which you will start the wizard. In order
to run the db2profile command:

1. Open a terminal console.
2. Change the directory to <DB2>.

3. Type the following in the command line and then press Enter:
..ldb2profile

4. Run the WBIMonitor424.jar file from the same terminal console.

You have to make sure also that the IBM JDK 1.3.0 is installed on your
machine. Alternatively, you can use the IBM JDK that is shipped with IBM
WebSphere Application Server.

To start the WBI Monitor Installation Wizard, run the WBIMonitor424 jar file by
doing the following:

* On Windows platform:
1. Start a command prompt window.
2. Type the following in the command prompt and then press Enter:

java.exe -jar GAWBIMonitor424.jar

Where G: is your CD drive name. Replace this name with the actual name of
your CD drive or with the location where the WBIMonitor424.jar file exists.

If the java.exe is not included in the Path environment variable path then type
the full path of java.exe (e.g. C:\WebSphere\AppServer\java\bin\java.exe).

* On AIX and Solaris platforms:
1. Start a terminal console as root.

2. Type the following in the command prompt and then press Enter:
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jJava -jar Itmp/WBIMonitor424.jar
Where /tmp is the location where the WBIMonitor424 jar file exists.

If the java is not included in the PATH environment variable, then type the full
path of java (e.g. "/lusriWebSphere/AppServerijavalbinljava" in AlX platform or
"lopt/WebSpherelAppServerijavalbin/java" in Solaris platform)

In the following sections of this chapter, you will be guided through the detailed
steps of using the WBI Monitor Installation Wizard to install the WBI Monitor

components.
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4.2 WRBI Monitor Server Installation

38

and Deployment

The Monitor Server component can be deployed automatically on WebSphere
Application Server using the WBI Monitor Installation Wizard by selecting the
Automatic Deployment as the deployment type.

The wizard will lead you through a set of steps to gather the required
information for the Monitor Server deployment, and then the wizard will deploy
the Monitor Server automatically.

The following are the wizard steps for installing and deploying Monitor Server:

1. The WBI Monitor Installation Wizard starts on the Welcome screen. For
all wizard steps, to go forward to the next step, click Next. To go back to
the previous step click Back. You can exit the wizard at any time by
clicking Cancel.
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2. The next screen is the License Agreement. Read the License
Agreement carefully and select the | accept the terms in the License
Agreement radio button to accept the agreement, then Click Next to
continue. If you select the | do not accept the terms in the License
Agreement then you will exit this installation wizard.
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3. Inthe next screen you should enter the Monitor installation directory
(<Monitor>) where the necessary folders and files will be extracted.
This directory also will be the WBI Monitor Working Directory. You can
accept the default path or change this path to a new folder. Then, you
can click Next to continue.
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4. The next screen is the Deployment Type where you can select one of
the following deployment types:
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- Manual Deployment: Selecting this option will only extract all
necessary folders and files that are required for deploying all WBI
Monitor components into the destination folder. In this case you will
need to perform the deployment of each component manually.

- Automatic Deployment: Selecting this option will let this installation
wizard perform all needed steps for installing the WBI Monitor

Components and perform the WBI Monitor Server deployment
automatically.
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Select the Automatic Deployment option and then click Next to
continue.

The next screen of the WBI Monitor Installation Wizard appears if you
select the Automatic Deployment option as the deployment type. In
this screen, you should select one or more of the WBI Monitor
components to be installed. Select the Monitor Server option to install

and deploy the WBI Monitor Server component and then click Next to
continue.
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6. Inthe next wizard screen you will be asked to enter the path and the
type of the Database JDBC driver file. For IBM DB2 database, this driver
file is named db2java.zip and is located in the <DB2>\Java12 folder.
For Oracle database, this driver file is named classes12.zip and is
located in the <Oracle>\jdbc\lib folder. Enter the required path or click
Browse to select the path. Then select the driver type from DB Driver
Type combo box. If the entered path is not correct, then you will be
informed by a message, and the wizard will not continue until you enter
the correct path. Then, you can click Next to continue.
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7. In the next screen you will be asked to enter the following information for
the Monitor database:

- In the Name/URL field, enter the Monitor database name (or the
database URL).

* If you are using Oracle database server, then type the following for
the Monitor database URL:
jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_ Number>:WFMDB

* Where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine, and
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521)

- In the User Name and Password fields, enter the user name and
password of the Monitor database administrator.

- In the Schema field, enter the Monitor database schema (The default
value is WFM).

*

In Oracle Database, the Monitor database schema must be the
same as the Database Administrator's User Name

The wizard will check the connection with the database using the
entered database name (or URL), user name and password. If one or
more of the entered parameters are not correct, then you will be
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informed by a message, and the wizard will not continue until you enter
the correct parameters. Then click Next to continue.
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The wizard will also check this database to verify if it is a newly created
database or a database of an earlier version of the WBI Monitor that
requires to be upgraded to the recent version's modifications. If the
specified database belongs to the previous version of WBI Monitor, then
a message will appear to tell you that the specified database belongs to
a previous version of WBI Monitor, and it needs to be upgraded using
the Database Migration Utility before starting this Installation Wizard.
Then the wizard will be terminated.

[z%_| Please refer to the section entitled WBI Monitor Database
Migration in Chapter 6: Upgrading your Existing Version of WBI
Monitor to the Recent Version in this guide for detailed
information about the Database upgrade.

8. After you enter the Monitor database information and if the , you should

specify the names of the required TableSpaces for each group of tables
and indexes in the Monitor database as follows:

- In the Default TableSpace field, type the name of the TableSpace that
you want to set as the default TableSpace. This TableSpace will be
used as the TableSpace of any tables or indexes group for which you
have not specified a TableSpace.

= If you leave this field empty, then the database default TableSpace
4 will be considered and used as the default TableSpace.
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- In the Administration section, type a TableSpace name for each of the
following:

* Administration Tables.
* Administration Indexes.

- In the Static Model Data section, type a TableSpace name for each of
the following:

* Static Model Data Tables.
* Static Model Data Indexes.

- In the Runtime Data section, type a TableSpace name for each of the
following:

* Runtime Data Tables.
* Runtime Data Indexes.

- In the Events Data section, type a TableSpace name for each of the
following: (These TableSpaces are used for the Event Queue (MQ
Workflow) database):

* Events Data Tables.
* Events Data Indexes.

- In the Process Data section, type a TableSpace name for each of the
following:

* Process Data Tables.
* Process Data Indexes.

- In the Security section, type a TableSpace name for each of the
following:

* Security Tables.
* Security Indexes.

- In the Large Objects TableSpaces section, type a TableSpace name
for each of the following:

* Static Model Lob.

* Process Data Lob.

* Configuration Data Lob.

* Notify Extra Data Lob.

* Event Data Lob.

* WBI Message Broker Lob.

You can specify a different TableSpace name for each group of tables or
indexes. Alternatively, you can specify the same TableSpace for more
than one group of tables or indexes. In the later case these groups of
tables and/or indexes will use the same TableSpace for storing the data
physically on the hard drive.
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If you leave a blank field without specifying a TableSpace name, then the
default TableSpace will be used for the corresponding group of tables or
indexes.

The specified TableSpace should have been previously created in the
Database server. Otherwise, the deployment will not be performed
properly and you will not be able to create the database tables.

Click Next to continue.
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9. In the next screen you will be asked to select the workflow engine(s) that
the WBI Monitor will monitor their run-time data. There are two workflow
engines that can be selected:

- MQSeries Workflow / WebSphere MQ Workflow
- WebSphere MQ Integrator (WMQI) / WBI Message Broker
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You can select one of these options or you can select a combination of them.
According to your selection, the wizard steps will vary to let you enter the
required information for the selected option as will be described in the following
sections.

If the specified WBI Monitor database belongs to a previous
version of WBI Monitor, then the MQSeries Workflow / WebSphere
MQ Workflow option will be selected by default and its check box
will be disabled so that you cannot de-select it.

4.2.1 MQ Workflow is Selected

46

If you select the MQ Workflow option, whether you select it alone or with
another option (WMQI and/or WICS), you must enter the following information:

* The MQ Workflow Configuration parameters.
* The MQ Workflow Database (the Event Queue Database) parameters.

In this case the WBI Monitor will be forced to authenticate the logged users to
WBI Monitor Client through the MQ Workflow. That means any user who will
login to WBI Monitor Client must be an MQSeries Workflow registered user, and
only MQSeries Workflow users have the privilege to log in to WBI Monitor
Client.

The following are the wizard screens that appear when you select the
MQSeries Workflow / WebSphere MQ Workflow option:
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1. In the next screen you will be informed that the wizard will check for the
existence of the IBM MQ Workflow and its database. Click Next to
continue.
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2. Inthe next screen you will be asked to enter the following IBM MQ
Workflow Configuration parameters in each corresponding field:

- BM MQSeries Workflow Library: The MQSeries Workflow library file
named fmcojagt.jar and located in the <MQ>\bin\java3320 folder if you
are using IBM MQSeries Workflow 3.3.2 or located in the
<MQ@Q>\bin\java3400 if you are using IBM WebSphere MQ Workflow
3.4. (You can click the Browse button represented as triple dots to
select this file).

- Locator: The MQSeries Workflow Locator Policy that is used to locate
the MQSeries Workflow Java Agent. This property can have one of the
following values: LOC, RMI, OSA, IOR, COS, or JNDI. The default is
LOC (Local Locator Policy)

- Agent: The MQSeries Workflow Agent's Name
- System: The MQSeries Workflow System's Name.
- System Group: The MQSeries Workflow System Group's Name.

- Encoding: The MQSeries Workflow Database encoding. (This
property must be set if the MQ Workflow Database encoding is
different from the Monitor Server machine encoding).
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Enter the required values for each corresponding field and click Next to
continue.
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B Important Note: In MQ Workflow, a default configuration must be

= efined even if the entered System Group and System belong to a
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3. Inthe next screen you will be asked to enter the following information for
the IBM MQ Workflow database (The Event Queue Database):

- In the Name/URL field, enter the MQ Workflow database name or the
database URL.

*

If you are using Oracle database server, then type the following
for the MQ Workflow database URL.:
jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:FMCDB
where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine, and
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521)

- In the Administrator and Password fields, enter the user name and
password of the MQSeries Workflow database administrator.

- In the Schema field, enter the MQSeries Workflow database schema
(The default value is FMC).

* |In Oracle Database, the Event Queue database schema must be
the same as the Database Administrator's User Name.
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- In the MQ Workflow Connector Queue section, type the TableSpaces
names for each of the following:

* Tables
* Indexes
* Large Objects (LOBSs)

You can specify a different TableSpace name for each of these three
fields. Alternatively, you can specify the same TableSpace for more
than one field. In the later case these groups of tables and/or indexes
will use the same TableSpace for storing the data physically on the
hard drive.

If you leave a blank field without specifying a TableSpace name, then
the default TableSpace will be used for the corresponding group of
tables or indexes.

The specified TableSpace should have been previously created in the
Database server. Otherwise, the deployment will not be performed
properly and you will not be able to create the database tables.

The wizard will check the connection with the database using the entered
database name (or URL), user name and password. If one or more of the
entered parameters are not correct, then you will be informed by a message,
and the wizard will not continue until you enter the correct parameters.

Click Next to continue.
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4.2.2 MQ Workflow is not Selected

50

If you select WebSphere MQ Integrator (WMQI) / WBI Message Broker and/or
WebSphere InterChange Server (ICS) as the workflow engine, without selecting
the MQSeries Workflow / WebSphere MQ Workflow, then you will be asked to
enter the information about the authentication and security type that you will use
to authenticate the logged users to the WBI Monitor Client, as long as you will
not use the MQ Workflow authentication.

The following are the wizard screens that appear when you select WebSphere
MQ Integrator (WMQI) / WBI Message Broker and/or WebSphere InterChange
Server (ICS) as the workflow engine:

1. In the next screen, select the security mode you want to apply. You have
the option to select one of the following security modes:

- Local Security: The Local security mode allows you to register any
user who is allowed to use the WBI Monitor locally in the WBI Monitor
database, so that each registered user's record contains the user
name and the password by which the logged user will be identified
each time he/she logs in to WBI Monitor Client.

- LDAP Security: The LDAP (Lightweight Directory Access Protocol)
security mode depends on acquiring the user authentication
information from an external LDAP server. The LDAP Serveris a
stand-alone, external server that holds a database of all employees
who have an identification record in the LDAP Server database. For
the LDAP Authentication method, any registered user in the LDAP
Server database can login to WBI Monitor client. When the user enters
his/her identification information (LDAP user name and password), the
LDAP server will check the information. If he / she passes the
authentication, then he will login to the WBI Monitor. The WBI Monitor
database does not hold the registered users' passwords that are used
for authenticating users. The WBI Monitor database holds only the
user name for setting the user's permissions.
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Select the appropriate security mode and then click Next to continue.
5 vt tontor st ot ey 10

@ Plesss selert ona of e seourdy modes you wend 1o apply for WE Bondor uners' suiPeeb abom

& Local Security: This Locsl Bcurity mode Shows you I Fegiier iy werwno i slowsd o use Be Wi
Woniar jocally in e BN Mondor datatase, 30 Tal oach reg UBErs record cottain the wser
MM el The BRI TWoRS by which he lo00ed riar will De idenied ach hene Paiuha loga in 10 Wi

oniior Client

= LIWAP Sacin iy The LOAF fughtawighl Dieclon Accats Profacal) pecurnly mods depindn on
BEGUITIng B ey SuEhenSCabion infprmation Bom an exdeensl LOAF server Ay registeesd wter in fe
LOWP Sasend dababape cin loge I VDI Mondor clierd Wi the user énden Fouhes identfic abcn
indyrernBon (LOWP Use maene and paaweed), e LOWP satent will check I infoematon If hadshe
pasies the stherdcalion, then baishe will lagm o e WEE Mondor, The WBI Mondod database doas
Rl hald ha teprilensd UL pEdrwerds il i uied o JUTEnBoEEng uien The WK Monsar
databsase holds only Bve wner nama for Seling 8 U3 e pRIMIT LG

Tiy b @ GeCUndy moce, selec P telewind radio buion

ek bt i conbees

Pliaid drdir P riquired nfonmatns

Eptactirpm M lodpeersg
= Local
" LOAP

sBack | Hear | canml |

2. The next screen appears only if you select the LDAP Security mode to
let you enter the required LDAP configuration parameters as follows:

- In the LDAP URL field: Type the LDAP Server URL and port number
(for example Idap://ldapsrvr:389/)

[z&_[ On AIX and Solaris platforms, type the LDAP server IP address
¥ instead of the server name

The remaining parameters are needed to allow logging in to WBI Monitor client
using only the User ID, instead of having to supply the full Distinguished Name
(DN). In this case, WBI Monitor queries the LDAP Server for the full DN of this

user using these parameters, and then uses the obtained full DN for login.

The required parameters are:

- In the Server Bind DN field: Type a Distinguished Name (DN) for an
LDAP Server authorized user that will be used for logging in to this
LDAP Server, and performing the search in the LDAP users' tree.

- In the Server Bind Password field: Type the password of the defined
User DN.

=Ly _| The Server Bind DN and Server Bind Password fields are optional.

¥ If you leave these fields empty without specifying a user then the
user anonymous will be used. In this case this user should have at
least read/search access rights on the LDAP directory.
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- In the Naming Attribute Holding Login ID field: Type the name of the
prefix that precedes the user ID in the LDAP Server database (i.e. CN,
UID,...etc). The value of this parameter varies between the different
types of LDAP Servers.

- In the Base of Search field: Type the starting point in the LDAP tree
from which the query will start searching for the full DN of the given
user ID.

- In the DN Attribute ID field: Type the name of the Distinguished Name
attribute 1D (for example distinguishedName, entrydn ...etc. This value
is case sensitive).
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- Click Next to continue.

4.2.3 Continuing the Wizard Steps

Now after entering the required information according to the selected engine,
the wizard steps will continue to complete installing the Monitor Server
component.

1. In the next screen, you will be asked to enter the Installed version of IBM
WebSphere Application Server and its installation path.

- Select the version of IBM WebSphere Application Server you are using
from the WebSphere Version drop down list (WebSphere 4 or
WebSphereb).

- Enter the location where the IBM WebSphere is installed:

* For IBM WebSphere Application Server, Version 4.0.2 & IBM
WebSphere Application Server, Version 5.0, enter the location of
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the AppServer folder that is located in the WebSphere installation
folder.

* For IBM WebSphere Deployment Manager (Network Deployment),
Version 5.0, enter the location of the DeploymentManager folder
that is located in the WebSphere installation folder.

Enter the required path or click Browse to select the path. If the entered path is
not correct, then you will be informed by a message, and the wizard will not
continue until you enter the correct path. Then, you can click Next to continue.
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2. Inthe next screen, you will be informed with the Monitor Server
installation summary. The wizard now is ready to start extracting the
necessary folders and files needed for installing the WBI Monitor Server
Component and then update the Monitor Enterprise Archive file
(monitor.ear) with the new parameters that you have specified in the
wizard steps. Click Next to continue.
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3. After extracting the necessary folders and files needed for WBI Monitor
Server deployment, the wizard now is ready to do the following:

- Generate the deployment script that is used for deployment.
- Deploy WBI Monitor using the generated deployment script.
You have the option to do either of the following:

* To generate the deployment script and deploy WBI Monitor, select the
Deploy check box.

* To generate the script only, clear the Deploy check box.

The created deployment script will be placed in <Monitor>\install directory. To
deploy the Monitor by using this script, run the batch file named
monitorinstall.bat in Windows platform (or the file named monitorinstall.sh in the
AIX or Solaris platforms) in the previous path. Now click Next to continue.
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4. Now the WBI Monitor Server installation has finished. You will need to
start the deployed Application Server from the WebSphere
Administrator's Console, in order to run WBI Monitor. Click Finish to exit
this installation wizard.
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4.2.4 Start the New Application Server

4.2.41 For IBM WebSphere Application Server 4.0.2

Start the WebSphere Administrator's Console.

2. In the WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers > MonitorServer and select Start
from the shortcut menu that appears.

3. Wait until the confirmation message appears, and then click OK.

4.2.4.2 For IBM WebSphere Application Server 5.0

You must restart the Default Server (server1) after you deployed the WBI
Monitor new Application Server. To do this:

1. On Windows platform, run a command prompt window. On AlX or
Solaris platforms start a terminal console window.

2. Change the directory to <WebSphere>\bin

Type the following command line:
stopServer servert

[z&_| For AlX and Solaris platforms, type stopServer.sh server1. This
4 command is case sensitive.

4. Wait until the Application Server is stopped and the confirmation
message appears, and then type the following command line:

startServer server1

25, For AIX and Solaris platforms, type startServer.sh server1. This
B command is case sensitive.

5. Wait until the Application Server is started and the confirmation
message appears.

4.2.4.3 For IBM WebSphere Deployment Manager
(Network Deployment) 5.0

Start the installed WBI Monitor Enterprise Application.

From the WebSphere Administrative Console, do the following:

1. From the left hand tree, select Applications > Enterprise
Applications. The Enterprise Applications page appears.

2. Select the IBM_WBI_Monitor application by selecting the check box
next to its name.

3. Click Start
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4.2.5 Finalize the Monitor Server Deployment

4.2.5.1 Initialize the Monitor Database

Run a Web browser (such as MS Internet Explorer)

2. Type the following URL:
http://<WebServerName><WebPath>/admin
(eg. http://monitorsrvr/monitor/admin)

The Login Page appears

3. Enter the User ID and Password of a valid user. (Please refer to the WBI
Monitor Administration Guide for detailed information about the WBI
Monitor authentication and security options). The Administration Utility
Web page opens.

4. Create the Monitor Database tables. Please refer to the WBI Monitor
Administration Guide for the detailed instructions of creating Monitor
database tables.

5. Close the browser.

4.2.5.2 Importing Organization XML Files

You have to import the required organization XML files to the WBI Monitor
database in order to complete the deployment instructions.

(5, | Please refer to the WBI Monitor Administration Guide for the
2" | detailed instructions of importing organization XML files.

4.2.6 WBI Monitor Server Un-Deployment

This section is used to completely un-deploy the Monitor Server from
WebSphere. To do this:

4.2.6.1 For IBM WebSphere Application Server 4.0.2

1. Stop the running MonitorServer application server.

2. Run the batch file named monitoruninstall.bat in Windows platform or
the file named monitorUninstall.sh in AIX or Solaris platforms. These
files are located in <Monitor>\install. This will uninstall WBI Monitor
automatically.

3. Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

4. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

© Copyright IBM Corp. 2002, 2003 57



58

4.2.6.2 For IBM WebSphere Application Server 5.0 and
IBM WebSphere Deployment Manager 5.0
1. Run the batch file named monitoruninstall.bat in Windows platform or

the file named monitorUninstall.sh in AIX or Solaris platforms. These
files are located in <Monitor>\install. This will uninstall WBI Monitor

automatically.

For IBM WebSphere Application Server 5.0, the log files are shared
between the different applications so that it will not be deleted.

2. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

This directory does not exist if you have deployed the WBI Monitor
Application Server on the default (base) Application Server named

serveri

3. Restart the WebSphere Application Server
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4.3 Installing the WBI Monitor Portlets
Component

The WBI Monitor Portlets component can be installed automatically using the
WBI Monitor Installation Wizard. This will install the four WBI Monitor Portlets
(Workflow Dashboard Portlet, Business Dashboard Portlet, Process Diagram
Portlet, and Notification Portlet) automatically into a specific WebSphere Portal
Server.

You will be guided through a set of steps to gather the required information for
installing this component, and then the wizard will install the Monitor portlets
automatically. Please refer to Chapter 4: IBM WebSphere Portal Support of the
WBI Monitor User Guide for detailed information about the support for
WebSphere Portal in WBI Monitor and how to install the WBI Monitor Portlets
manually.

[z%_| Important Note: The Monitor Server installation and deployment
¥ must be performed before installing the WBI Monitor Portlets
component.

The following are the WBI Monitor Installation Wizard steps for installing the
Portal component:

1. The WBI Monitor Installation Wizard starts on the Welcome screen.
Click Next to continue.

2. Inthe License Agreement step, accept the License Agreement and click
Next to continue.

3. Enter the Monitor installation directory where the necessary folders and
files will be extracted. Then, click Next to continue.

4. Inthe Deployment Type step, select Automatic Deployment and click
Next to continue.

5. In the Installed Component step select the WBI Monitor Portlets
option and click Next to continue.
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In the next wizard screen that appears after the Installed Component

screen, you will be asked to enter the required configuration parameters
of the WebSphere Application Server and WebSphere Portal Server as
the following:

- In WAS Directory field, enter the location where the IBM WebSphere
Application Server is installed (For example:
CA\WebSphere\AppServer). You can click Browse to select the
directory location.

- In the Portal Directory, enter the location where the IBM WebSphere
Portal Server is installed (For example: CA\WebSphere\WebSphere
Portal). You can click Browse to select the directory location.

- In the Domain field, enter the DNS Domain name on which the
WebSphere Portal server is installed. (for example: egy.ibm.com)

- In the Portal Administrator User Name and Password fields, enter
the user name and password of one of the WebSphere Portal Server
administrators that will be used to login to the Portal Server and
perform the installation.

- In the Configuration Page URL field, enter the URL that is used to
access the portal configuration servlet. This URL consists of the portal
host name, the base URL for the portal, as specified during installation
(for example /wps), and the servlet extension (/config).
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Click Next to continue
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7. In the next screen, you will be informed with the Portal installation
summary. The wizard now is ready to start installing the WBI Monitor
portlets on the specified WebSphere Portal Server.

Click Next to continue.
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8. Now the WBI Monitor Portlets installation has finished. Click Finish to
exit this installation wizard.
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4.4 Installing the Monitor LDAP Bridge
Component

The Monitor LDAP Bridge component is necessary to be installed if you are
using IBM WebSphere MQ Workflow 3.4 that depends on an LDAP server for
acquiring the users’ information. In this case any changes in the users'
information/definition that occurs in the LDAP server and are reflected in the
MQ Workflow should be also reflected in WBI Monitor in order to update the
processes and organization information in WBI Monitor with the changed
information in MQ Workflow.

Installing the Monitor LDAP Bridge component will extract only a folder named
Idapbridge in the specified destination directory. This folder contains a single .jar
file named Idapbridge.jar. By running this jar file the users information in WBI
Monitor will be updated with all changes that occurred in the LDAP Server from
which the MQ Workflow obtains the users information.

25, Important Note: The Monitor Server installation and deployment
B must be performed before installing the Monitor LDAP Bridge
component.

The following are the WBI Monitor Installation Wizard steps for installing the
Portal component:

1. The WBI Monitor Installation Wizard starts on the Welcome screen.
Click Next to continue.

2. Inthe License Agreement step, accept the License Agreement and click
Next to continue.

3. Enter the Monitor installation directory where the necessary folders and
files will be extracted. Then, click Next to continue.

4. Inthe Deployment Type step, select Automatic Deployment and click
Next to continue.

5. In the Installed Component step select the Monitor LDAP Bridge
option and click Next to continue.
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6. Once you select to install the LDAP Bridge component from the Installed
Components step and clicked Next, you will be informed with the
Monitor LDAP Bridge installation summary. The wizard now is ready to
start installing the Monitor LDAP Bridge folder on the specified

destination directory.
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Click Next to start the installation.
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7. Now the Monitor LDAP Bridge installation has finished. Click Finish to
exit this installation wizard.

T <l =]

The InstaliShield WWizard has successidly instalied WaiMontor, Choose Finish o e e wizan

4.4.1 Running the Monitor LDAP Bridge

After you have installed the Monitor LDAP Bridge component, you will need to

run the installed jar file periodically in order to update the WBI Monitor database
with the changes that occurred in the LDAP Server on which the MQ Workflow
acquires the users' information.

To run the Monitor LDAP Bridge:
* On Windows platform:
1. Start a command prompt window.
2. Type the following in the command prompt and then press Enter:

java.exe -jar <Monitor> \Idapbridge\ldapbridge.jar -f <FDLFile> -u
<MonitorAdminUserName> -p <MonitorAdminPassword> -s
http://<WebServerName><WebPath>

(5, If the java.exe is not your environment variable path then type the
= fun path of java.exe (e.g. C:\WebSphere\AppServer\java\bin\
java.exe)

* On AIX and Solaris platforms:

1. Start a terminal console using root.
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2. Type the following in the command prompt and then press Enter:

java -jar <Monitor> \Idapbridge\ldapbridge.jar -f <FDLFile> -u
<MonitorAdminUserName> -p <MonitorAdminPassword> -s

http://<WebServerName><WebPath>

If the java.exe is not your environment variable path then type the
full path of java.exe (e.g. "/usriWebSpherelAppServerijavalbin/
java" in AIX platform or "/lopt/WebSpherelAppServerljavalbin/java"”

in Solaris platform

Where:
* <FDLFile>: The full path and name of the FDL file that has been produced

by running the MQ Workflow LDAP Bridge. This file contains the updated
information for the organization units and their users that have been
changed in the LDAP Server and have been updated in the MQ Workflow.

* <MonitorAdminUserName>: A valid user name for a WBI Monitor

administrator.
* <MonitorAdminPassword>: the password of the specified administrator's

user name.
* http://[<WebServerName><WebPath>: The web address that is used to
access the WBI Monitor Client. (for example: http://MonitorServer/

monitor).
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4.5 WBI Monitor Clustering Support
for WebSphere Deployment
Manager

As one of the major features of the IBM WebSphere Application Server v5.0.x,
WBI Monitor supports clustering deployment using the WebSphere 5.0.x
Application Server and Deployment Manager.

A Cluster is a set of application servers that are managed together for the
purpose of failover handling and participate in workload management. The
servers that are members of a cluster can be on different host machines, as
opposed to the servers that are part of the same node and must be located on
the same host machine.

Servers that belong to a cluster are members of that cluster set and must all
have identical application components deployed on them. Please refer to the
WebSphere Application Server and Deployment Manager v5.0.x documentation
for details about creating and configuring clusters.

In order to install and deploy the WBI Monitor in a cluster, there are two possible
cases:

* If you already have an existing cluster that is configured and its members
have running web applications, then you must install and deploy the WBI
Monitor on each member in that cluster using the manual deployment
steps (not the WBI Monitor Installation Wizard). Notice that each node
must point to the same database(s).

* If you are building a new cluster or adding a new node to a cluster on
which the WBI Monitor is installed and deployed, then you should install
and deploy the WBI Monitor on each cluster member, either automatically
using the WBI Monitor Installation Wizard or manually by performing the
manual deployment steps. Notice that each node must point to the same
database(s). This must be done before adding each machine to the
cluster.

[z%_| Please refer to Appendix B of this guide: Manual Deployment of
4 WBI Monitor on WebSphere 5.0 for a description of the manual
deployment of Monitor Server on WebSphere 5.0
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4.6 WBI Monitor Un-Installation

This section describes how to completely uninstall the WBI Monitor from your
machine using the WBI Monitor Uninstallation Wizard in order to remove all
folders and files that was installed by the WBI Monitor installation wizard. The
WBI Monitor Uninstallation Wizard starts by running the jar file named
uninstall.jar that is located in the <Monitor>\_uninst folder.

Before starting the WBI Monitor Uninstallation Wizard, make sure that the IBM
JDK 1.3.0 is installed on your machine. Alternatively, you can use the IBM JDK
shipped with IBM WebSphere Application Server.

To start the WBI Monitor Uninstallation Wizard:
1. Run the uninstall.jar file by doing the following:
- In Windows platform:
* Start a command prompt window.
* Type the following in the command prompt and then press Enter:

Java.exe -jar <Monitor>\_uninsf\uninstall.jar

(5, If the java.exe is not your environment variable path then type the
B full path of java.exe (e.g.
C:\WebSphere\AppServer\java\bin\java.exe)

- In AIX and Solaris platforms:
* Start a terminal console using root.
* Type the following in the command prompt and then press Enter:

Java -jar <Monitor>/_uninst/uninstall jar

2%, | If the java.exe is not your environment variable path then type the

o full path of java.exe (e.g. "/usriWebSpherelAppServerijavalbin/
java" in AIX platform or "/opt/WebSpherelAppServerljavalbin/java"”
in Solaris platform
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2. Once you start the Uninstallation wizard, a Welcome dialog box
appears. Click Next to continue through the wizard or click Cancel to
exit the wizard.

4 Uninstaller =100] x|

Velcome 1o the InstaliShield Wizard for WEIMonitor

[(Hed> ||  cancal I

3. The next screen contains the Home Directory on which the WBI Monitor
was installed and the installed components. Click Next to start removing
these installed components and remove the files and folders from your

hard drive, Back to return to the previous step, or Cancel to exit the
wizard.

4 Uninstaller =10] x|
‘WEiMonitor will be uninstalled fram the following location

CoABiMonitord 24
‘with the fallowing featuras:

Saner

Portal
LDAP bridge

<gack | Nex> |  Cancel |

4. After all files and folders are removed from your hard drive, the next
screen will tell you that the Uninstallation Wizard has finished
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uninstalling the WBI Monitor from your system. Click Finish to exit the
wizard.

4 Uninstaller h ;LQiE.‘J

The InstaliShield Wizard has successiully uninstalled WEIMandor. Choose
Finlah o exdt the wizard.

InstaliEhi=id

! Finlsh H
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Appendix A: Manual Deployment of
WBI Monitor on
WebSphere 4.0.2

This appendix describes the manual steps of deploying WBI Monitor on IBM
WebSphere 4.0.2. Before starting these steps, it is assumed that the Monitor
Database (and Event Queue Database if you are using MQ Workflow as your
engine) with the required Table Spaces are created and configured in your
Database Server.

The following conventions are used for all the instructions throughout this
document:

- <WebSphere> = The WebSphere home directory. e.g. C:\Websphere

- <MQ> = The MQ Workflow home directory. (e.g. c:\fmcwinnt on
Windows platform, /user/fmc on AlX platform, or /opt/fmc on Solaris
platform)

- <DB2> = The DB2 home directory. e.g. c:\sqllib

- <Oracle> = The Oracle home directory on the Oracle Server machine
(if Oracle is not running on the same machine on which the IBM
WebSphere Application Server is installed). e.g. C:\oracle\ora81
(Local) or \\oracle_machine\oracle\ora81 (Network)

- <Monitor> = The Monitor installation directory where the WBI Monitor
has been installed. e.g. C:\WBIMonitor

- <WebServerName> = The name of the machine that hosts the Web
server for which the WebSphere is configured. (Ex. The machine name
on which the IBM HTTP Server or Microsoft 1IS 4.0 or IIS 5.0 is
installed)

- <ServerName> = The name of the server on which the Monitor will be
installed.

On AIX and Solaris platforms, use forward slash / instead of back-slash \ when
writing paths.

Important notes:
- The names and paths of folders and files are case sensitive.

- Make sure that the user you are using have all needed permissions.
For example, using a user who has no permissions on WebSphere or
the Database will fail to deploy the monitor.

- On AIX 5.1 platform, the environment variable named LIBPATH must
be appended with the following pathes: <MQ>/lib and <MQ>/lib/
magqserver. To do this, type The following command in the console
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window from which you will start the WebSphere and then press Enter:
export LIBPATH=$LIBPATH:<MQ>/lib:<MQ>/lib/mqgserver

- The Monitor will not work if the server properties
client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.

If you are using WebSphere Application Server 4.0.5, the property
client.encoding.override=UTF-8 should be added explicitly in the
server JVM's settings.
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1 Monitor Server Deployment
1.1  Configure IBM WebSphere

B In Windows NT or Windows 2000, make sure that the IBM WS
4 AdminServer service is started and running.

The purpose of these steps is to create and configure a new Application Server
in WebSphere. The Application Server resides inside the Monitor Server.

In order to perform this operation, start the WebSphere Administrator’s
Console and perform the following steps:

1.11 Create JDBC Provider and Data Sources

25, If a previous driver is already created and installed, then you can
¥ skip the following steps for creating and installing the database
drivers for the data source.

You need to create the required Database Drivers and their Data Sources. The
creation of the Database Drivers and their Data Sources should be performed
as the following sequence:

1. If you are not using IBM MQ Workflow as your engine or If the Monitor
database and the Event Queue database are located in the same
physical database:

- Create and install only one Pool Database Driver.

- Create only one Pool Data Sources under the created Pool Database
Driver points to the Monitor database.
2. If the Monitor database and the EventQueue database are located in
two physical databases:
- Create and install one Pool Database Driver.

- Create two Pool Data Sources under the created Pool Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

- Create and install one XA Database Driver.

- Create two XA Data Sources under the created XA Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

The following table provides the required values for the each Database Driver
and Data Source as you should enter through the creation steps:

For Monitor Pool JDBC Provider:
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Property/Field DB2 Oracle

Name

Name MonitorDB2PoolDriver MonitorOraclePoolDriver
Database JDBC db2java.zip classes12.zip

Driver File Name

Database JDBC <DB2>\java\ <Oracle>\jdbc\lib

Driver File path

Implementation COM.ibm.db2.jdbc.DB2Connection | oracle.jdbc.pool.OracleConnection
Class PoolDataSource PoolDataSource

For Monitor Pool Data Source:

Property/Field Name

Value

Name

Monitor_Pool_DataSource

JNDI Name

MonitorPoolDataSource

For Event Queue Pool Data Source:

Property/Field Name

Value

Name

Event_Queue_Pool_DataSource

JNDI Name

EventQueuePoolDataSource

For Monitor XA JDBC Provider:

Property/Field DB2 Oracle
Name
Name MonitorDB2XADriver MonitorOracleXADriver
Database JDBC db2java.zip classes12.zip
Driver File Name
Database JDBC <DB2>\java12\ <Oracle>\jdbc\lib
Driver File path
Implementation COM.ibm.db2.jdbc.DB2XADataSource | oracle.jdbc.xa.client.OracleXADataSource
Class
For Monitor XA Data Source:
Property/Field Value
Name
Name Monitor_XA_DataSource
JNDI Name MonitorXADataSource
For Event Queue XA Data Source:
Property/Field Name Value
Name Event_Queue_XA_DataSource
JNDI Name EventQueueXADataSource
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The following sections describe the required steps that you should follow to
create and install a JDBC Provider and to create a Data Source under this
driver:

Create and Install the JDBC Provider

Creating a JDBC Provider:
To create a JDBC Provider:

1. Expand the WebSphere Administrative Domain tree, and select
Resources > JDBC Providers

2. Right-click the JDBC Providers and select New from the shortcut menu

that appears.

=58 vwebSphere Administrative Domain

-~ virual Hosts

-2 Server Groups

H-E3 Modes

--F_'I Enterprise Applications

=-E3 Resources
SR=R IDEC Providers
. [#-@ Sample DB Mewy...
=3 Javahlail Sessic Find...

FOE= im e

The JDBC Provider Properties dialog box appears
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¥ IDBC Provider Properties =] =]

monitorDB2Driver

COM.ibm.dbZ jdbec. DBEZEADataSource L

- Type database driver name in the Name box.
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- Click the Browse button (represented by triple dots) next to the
Implementation Class field. The Select an Implementation Class
dialog box appears.

4 Select an Implementation Class -0 x|

COM.ibm.db2 jdbe.DBZ2ConnectionPoolDataSource
comibm.as400.access AS400JDBCConnectionPoolDatasSource
com.ibm.db2 jdbc.app.DBZStdConnectionPoolDataSource
aracle jdbc.pool.OracleCaonnectionPoolDataSource
com.svbasejdbc jdbe. SybhConnectionPoolDataSource
com.merant.zequelink jdhex.datasource SequelinkDataSource
com.merant.datadirect jdbex sglserver. SQLSenverDataSource
comm.ibmeejs.cm.potabilit IDBConnectionPoolDataSource

|»

COM.ibm.db2 jdbe DBZADataSource
comibm.as400.access AS400JDBCHADataSource

comibm.db2 jdhc.app DBZStdADataSource
oracle jdboxa.client OraclexXADataSource

com.sybase jobc? jdbc SybEADataSource ;I
Ok Cancel Help |

- From the Implementation Classes list, select the appropriate
implementation class for the database driver according to the above
table.

- Click OK. The dialog box will close and you will return to the JDBC

Provider Properties dialog box where the selected class appears in

the Implementation Class field.

Installing the Created Database Driver
To install the created JDBC Driver:
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1. While you are in the JDBC Provider Properties dialog box, select the
Nodes tab.

"% JDBC Provider Properties 0] x|

General Modes

This JDBC Provider is installed on the Modes below.

MHode Classpath Install Bew...
rmanitorser CAUBMSALLIENava1 ..
Irinstall
Mode:
Classpath:
] Cancel

2. Click Install New, the Install Driver dialog box appears.

"4 Install Driver - 10| x|

Select a node an which you want to install the driver.

monitorsmer

Ciriver file (CABMSQLLIBYava1 Zdb2java Zip, ! Specify Driver...

Install Cancel
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3. Select <ServerName> from the Nodes list, and click Specify Driver in
order to select a driver to be installed for the node. The Specify the
Driver Files dialog box appears.

¥ Specify the Driver Files _ (O] x|
Specify the path to the implementation files for this provider

MSALLIENava1 AdhZjava Zip Add Diriver... I

Femove |

Set | Cancel |

4. Click Add Driver. The Open dialog box appears.

Look in: |_| ja...;l

3 camman.jar
&) databean jar
[ db2javazip
& ioraph jar
runtirme zigp
& solasstjar
& swingall jar =

File narme: |dh2jaxra.zip Qpen

Files oftype:  [JARS/ZIPS (zip,jan »|  Cancel

5. Select the appropriate JDBC driver file name and path according to your
database server type, and click Open.

6. Select the added driver in the Specify the Driver Files dialog box and
click Set.

Click Install in the Install Driver dialog box.

Click OK in the JDBC Provider Properties dialog box. The Database
Driver will be installed.

Creating a Data Source

To create a Data Source to point to a Database and a Communication Driver:
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'i‘Tr Data Source Properkties _ IDIEI

Expand the WebSphere Administrative Domain tree, and select
Resources > JDBC Providers> <DatabaseDriverName> Data
Sources

Right-click Data Sources and select New from the shortcut menu that
appears.

=98 WebSphers Administrative Domain
-~ Wirtual Hosts
2 Server Groups
+-E3 Modes
--F_'I Enterprise Applications
=0 Resources S
=0 JDBC Providers
- #-@ Sample DB Driver
=@ MonitorDB 2Driver

(F= 30 ata Source
2 JavaMail Sessions
+-E2 URL Providers Find...

- The Data Source Properties dialog box appears.

| Cannection F'clnlingl

Pleasze read the help for information on configuring data sources.
Marne: *|

JHDI narme: |

Description:

JOBC pravider: *MaonitarDB2Driver
—Custam Properies

Marme Yalue Add |
* |databaseMame |

user Eermave
password
connectionAttribute
description
language
logWriter ;l

Test Connhection |

e I Cancel Help

- Type the Data Source name in the Name box.
- Type the Data Source JNDI name in the JNDI name box.
- In the Custom Properties table:
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- Type the name of the database to which the created Data Source
points in the Database Name field. (For example WFMDB for Monitor
database or FMCDB for MQ Workflow database. If you created the
Monitor Database or the Event Queue Database with a different name,
then you should type this name in the Database Name field.).

* For Oracle database, the field name is URL and it should be filled
with the database URL instead of the database name. (For
example
jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:>:<DatabaseName>

Where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine,
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521) and <DatabaseName> is the
database name (for example WFMDB for Monitor database or
FMCDB for MQ Workflow database. If you created the Monitor
Database or the Event Queue Database with a different name,
then you should type this name in the Database Name field).

'."i Data Source Properties o] |

Please read the help for information on configuring data sources.

Mame: *|ru1 onitar_sA_DataSource
JMDIname:  |wonitorsADataSource
Description: sm DataSource for Manitor Application

JOBC provider: *MonitorOraclex=ADriver
Custom Properies

MHame Yalue Add |

* |password e N
= |URL idbc:nracle:thin:@nraJ |

" o|user F i
looriter
senertame
descriptian
TMSEntryMame =

Test Connection |

I Cancel Help

- Type the Database connection user's name and password in the User
and Password fields.
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You can test the connection with the Database with the entered
user name or password by clicking Test Connection. If the
Database name, user name or password is not correct, then you
will be notified by a message. Otherwise, another message will
confirm that the connection is successful.

Click OK. The Data Source will be created.

1.1.2 Create a new Application Server

Now your next step is to create a new Application Server for WBI Monitor.

1. In the WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers and select New from the
shortcut menu that appears.

EI--@:@ WebSphere Administrative Domain P
----- 2 virtual Hosts e
----- £3 Server Groups
=-E2 Modes
=169 monitorsrer
EHE- Application Semver
- [H@)) Default Server
=7 Generic Servers

™ A . i
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The Create Application Server dialog box appears.

¥ Create Application Server - |I:I|5|

General |Advanced| FiIeI Tranaactiunl S Beﬁingal Sewicesl Cuatuml

Application Server name: *|ru1|:|nit|:|rEenfer

Mode: fmonitorsrer =l
Ervironment: | Environment... |
Waorking directony: |C:1mnnitu:ur421

Mode startup state: Last state =l
Maximum starup attermpts: |2 attermpts
Module visibility [#pplication =

(0] I Cancel Help

- In the General tab:
* In the Application Server Name box, type MonitorServer.
* In the Working Directory box, type <Monitor>
* In the Module Visibility combo box, select Application.

* Leave the other fields as default
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- In the File tab:

®ei Create Application Server - |I:I|5|

General | Advanced File I Transaction | JvM Settings | Sewices | Custom |

Standard input: |

Standard output:  flogsistdout log

Standard errar: |||:.g5f,atderr,|ng

—File permissions

Specify what permissions WebhSphere Application Server should use
wwhen creating the files ahove.

OWner [ Read | Write [ Execute
Group: [ Read [ Write [ Execute
Other [V Read [ Write [ Execute

Ol I Cancel Help

Leave the Standard Input box blank
In the Standard Output box, type logs/stdout.log
In the Standard Error box, type logs/stderr.log

Leave the check boxes in the File Permissions frame with their
default settings.

- In the JVM Settings tab:

IBM WBI Monitor - Deployment Guide



¥4 Create Application Server -0l x|

F

Initial java heap size: |54 [1]=]

Maximurm java heap size:  [28 []=]
—Classpaths
Marme | Add
Rermaye
—System Properies
Marme Yalue Add
Rermove
Advanced Jvh Settings... |
Generated Command Line Arguments:
FtrnsBarn - 28m S
Ik | Cancel Help |

* In the Initial Java Heap Size box, type 64
* In the Maximum Java Heap Size box, type 128

* If you are using MQ Workflow as your engine then do the following
in the Classpaths section:

- Click Add. A new empty line appears in the Classpaths table
under the Name column.

- Type in the added line the full path and name of the MQ
Workflow library file named fmcojagt.jar and located in the
<MQ>\bin\java3320 folder if you are using IBM MQSeries
Workflow 3.3.2 or located in the <MQ>\bin\java3400 if you are
using IBM WebSphere MQ Workflow 3.4.

* If you are using WebSphere Application Server 4.0.5, then the
property client.encoding.override=UTF-8 should be added as in
the following steps:

- In the System Properties list, click Add
- Type client.encoding.override in the Name field.
- Type UTF-8 in the Value field.

- Click OK. The new application server will be created.
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1.1.3

Configure the WBI Monitor Initial Parameters

Now you should configure the WBI Monitor initial parameters. This is done
through the WebSphere Application Assembly Tool.

To configure the WBI Monitor initial parameters:

1.

o g bk~ w b

From the WebSphere Administrator's Console, Select Tools
>Application Assembly Tools from the menu.

The Application Assembly Tool window opens.

Click Cancel to close the welcome screen.

Select File> Open from the menu. The Open dialog box appears.
Select the monitor.ear file located under the <Monitor>\servenserver.
Expand the tree on the left.

Add the required environment entries (parameters) in the Environment
Entries node under the session bean of the following modules:

- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the WICS_Connector_ID module
* WICSConnector bean.
- For the Connector_ID module.
* MQWFConnector bean.
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& Apphication Assembly Tool

File Edt Wi

a- & 3

Window  Help

hE XdF o8 W

& Application Assembder . Dshared Assmmdmonitor ea

=120 15M_WEI_Monior
= ¢ EJB Modules
= g4 Monitor
=M Session Beans
= (@) ClientAgent
a

8 EJB Refarences
3 Resource References
8 Secwity Role Réferances
O Memod Extengions
" Cleanupagent
* Maotific ationAgent
* EventProcessor
* DEBridge
£ Enftily Beans
1 Secwity Roles
8 Memhod Permissons
8 Container Transactions
TP Filos
% g3 Connectar D
= g4 wmGl_Connector_iD
+ o Web Modules
* o Application Clients
8 Secwity Roles
TP Fites

|2

Harni | vae | Type | Deseription |
+» mondor dbegSchema FMC B¥ing
+h mondordb schema WFM S¥ring
5 MOnAor i snablid false S¥ing
% MOonAoE Frewt @nabled g Swing
&5 MOonAnE Fregw loc aloe LoG S¥ing
€ Mondor security msde L] S¥ing
5 Monfor wmal enabled ug S¥ing

General |
Erndronament ardrios define variables used fo customize the business logic for an
application

Mame: Tronitor db egSthema
Walug: i

Type: 5wng

Dascription

| |

The following table lists the required parameters that should be entered for each

session bean.

Property Name / EJB Name:

monitor.db.schema

< | ClientAgent

< | CleanupAgent

< | NotificationAgent
< | EventProcessor
< | MQWFConnector
< | WMQIConnector
< | WICSConnector

< | DBBridge

monitor.db.eqSchema

AN

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modelindexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

monitor.db.tablespaces.processDataTables

S 1 N 1 N T U N N N B N N
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monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalLob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDataLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

monitor.db.tablespaces.mbDetailLob

NI I AN AR N AN B N BN B NE RN

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqlndexes

monitor.db.tablespaces.conDetailDataLob

monitor.db.tablespaces.defaultTablespace

IR ERNE RN

monitor.wics.enabled

monitor.wmqi.enabled

monitor.mqwf.enabled

monitor.security.mode

monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

monitor.mqwf.locator

monitor.mqwf.agent

monitor.mqwf.system

monitor.mqwf.sysGroup

NI N N N N N N N RN BN BN RN

SESSS

monitor.mqwf.encoding

v

The following table provides the description of each parameter.

Parameter Name Type | Value Description

monitor.db.schema String | The Monitor Database Schema. The default value is WFM

monitor.db.eqSchema String | The MQSeries Workflow Database (Event Queue Database)
Schema. The default value is FMC
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monitor.mqwf.enabled

String

Type True if you are using MQ Workflow as your engine or False
otherwise.

monitor.wmgi.enabled String | Type True if you are using WMQI as your engine or False
otherwise.

monitor.wics.enabled String | Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode String | The applied security mode:
» Type MQ for MQ Workflow security mode if you are using MQ

Workflow as your engine.
» Type LDAP for LDAP security mode or Local for local security
mode if you are only using WMAQI as your engine.

monitor.security.ldap.url String | The LDAP Server URL and port number (for example Idap://
Idapsrvr:389/).
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn String | A Distinguished Name (DN) for an LDAP Server authorized user
that will be used for logging in to this LDAP Server, and perform-
ing the search in the LDAP users' tree.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.password String | The password of the defined User DN.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.naming.attr | String | The name of the prefix that precedes the user ID in the LDAP
Server database (i.e. CN, UID,...etc). The value of this parameter
varies between the different types of LDAP Servers.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.root String | The starting point in the LDAP tree from which the query will start
searching for the full DN of the given user ID.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn.attr.id String | The name of the Distinguished Name attribute ID (for example
distinguishedName, entrydn ...etc. This value is case sensitive).
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.mqwf.locator String | The MQSeries Workflow Locator Policy that is used to locate the
MQSeries Workflow Java Agent. This property can have one of
the following values: LOC, RMI, OSA, IOR, COS, or JNDI. The
default value is LOC (Local Locator Policy)

monitor.mqwf.agent String | The MQSeries Workflow Agent's Name

monitor.mqwf.system String | The MQSeries Workflow System's Name

monitor.mqwf.sysGroup String | The MQSeries Workflow System Group's Name

monitor.mqwf.encoding String | The MQSeries Workflow Database encoding. (This property must

be set if the MQ Workflow Database encoding is different from the
Monitor Server machine encoding)
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In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define
this property then the database user default TableSpace will be used as
the default TableSpace.

Parameter Name

Type | Value Description

monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database

Administration tables.

monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database

Administration indexes.

monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static
model tables.
monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static

model indexes.

monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database

Security tables.

monitor.db.tablespaces.securitylndexes String | TableSpace name of the Monitor Database

Security indexes.
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monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.
monitor.db.tablespaces.processDatal.ob String | TableSpace name of the Monitor Database
Process Data LOB.
monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.
monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.
monitor.db.tablespaces.eventDatal ob String | TableSpace name of the Monitor Database Event
Data LOB.
monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.
monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.
monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .
monitor.db.tablespaces.eqlndexes String | TableSpace name of the MQSeries Workflow
Database Event Queue indexes.
monitor.db.tablespaces.conDetailDatal.ob String | TableSpace name of the MQSeries Workflow
Database Configuration Detail Data LOB
monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used

for any tables or indexes category that has not
been assigned to a specific TableSpace.

Important Note: In Oracle Database, the Event Queue database
schema and the Monitor Database Schema must be the same as

the Database Administrator's User Name.

different configuration.

Important Note: In MQ Workflow, a default configuration must be
defined even if the entered System Group and System belong to a

To add each one of these parameters, do the following:
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- Right click inside the right-hand table, and select New from the shortcut
menu that appears. The New Environment Entry dialog box appears.

New Environment Entry = x|

Ervironmeant entries define vaniables used fo customize the business logic for an
application.

Mama: |

Value: |

Type: ‘|Sl;|||'||:] j
Description: I

ok | moy | cancal | Hew

- Type the parameter name in the Name field.

- Type the parameter value in the Value field.

- Select the parameter type from the Type drop down list.

- Click OK. The new parameter will be added to the table.
7. Select File > Save from the menu to save the monitor.ear.

8. Exit the Application Assembly Tool.

1.1.4 Install the WBI Monitor Enterprise Application

Now you will create and install an Enterprise Application for WBI Monitor.

1. From the Console > Wizards menu, select Install Enterprise
Application. The Install Enterprise Application Wizard will start
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2. Inthe Specifying the Application or Module screen:

" Install Enterprise Application Wizard

Specifying the Application or Module
Specify the applicaion{EAR file) or module(JAR or WAR file) thal you want lo install.
liyou install a stand-alone module, you must specify a new application name y

]
|

Browse for filé on noda: izarara =

i+ Install Application (.ear)

Patih | owEIMonitofsareAROnROT & ar Browse.._ |

Application nanme: BN _WwWBIL Monilor

" Install stand-alone module (.war, = jary
1 |
|

Help | I Mext > I I Cancel I

- Select the <ServerName> node from the Browse for file on node:
combo box if it is not displayed by default.

- Select the Install Application (*.ear) radio button.
- In the Application name box, type IBM_WBI_Monitor

- Click the Browse button to locate the monitor.ear file. The Open dialog
box appears.

* Select the monitor.ear file from the <Monitor>\servenserver.

* Click Open. The file will be selected and you will return to the
Specifying the Application or Module screen

- Click Next.
In the Mapping Users to Roles screen, click Next.
In the Mapping EJB RunAs Roles to Users screen, click Next.

In the Binding Enterprise Beans to JNDI Names screen, click Next.

o g W

In the Mapping EJB References to Enterprise Beans screen, click
Next.

7. In the Mapping Resource References to Resources screen do the
following:

- If the Monitor database and the Event Queue database are located in
the same physical database (one database), then all resource
references should be mapped to the same physical data source
named Monitor_Pool_DataSource.
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- If the Monitor database and the Event Queue database are located in
two physical databases, then map each resource reference to the
appropriate resource according to the following table:

Resource Ref. Module Data Source Name Data Source JNDI Name
jdbc/MonitorDataSource MQWFConnector Monitor_XA_DataSource MonitorXADataSource
jdbc/EventQueueDataSource MQWFConnector Event_Queue_XA_DataSource EventQueueXADataSource
jdbc/ MQWFConnector Event_Queue_Pool_DataSource EventQueuePoolDataSource

PoolEventQueueDataSource

jdbc/MonitorDataSource CleanupAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource ClientAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource EventProcessor Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource NotificationAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource WMQIConnector Monitor_Pool_DataSource MonitorPoolDataSource

To perform the mapping:

- Select the resource reference you want to map to a specific data
source from the Resource Reference column.

- Click Select Resource. The Select Resource dialog box appears.

"i select Resource

\9) Select Resource
Event_Queue_Poal_DataSource [

Ok Cancel |

- Select the appropriate Data Source name from the Select Resource
drop down list and click OK. The resource reference will be mapped to
the selected resource and the JNDI Name of the selected data source
will appear in the mapping table in the JNDI Name column.

- Click Next to continue.

8. In the Specifying the Default DataSource for EJB Module screen,
click Next.

9. In the Specifying DataSources for Individual CMP Beans screen,
click Next.

10. In the Selecting Virtual Hosts for Web Modules screen, click Next.
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11. In the Selecting Application Server screen:

"t Install Enterprise Application Wizard

Selecting Application Servers

Specify the applicalion server whong you wanl bo install modules containad in your
application. Modules can be installed on the same server or dispersed among
sevaral seners

i Belect a module In the list below and click he Selact Server bution 1o select he application
:%. | server onwhich o install the module.

Module | Application Server | [ SeieciSemer I

Monifor HDHI'lDrSE'N‘EHmDI‘II!DrSH'T_:I

near{maonitorsnm

Help < Back |_§mﬂr I ] I Cancel |

- Select Monitor from the Module column.

- Click Select Server. The Select a Server or Server Group dialog box

appears.

Select a Server or Server Group il

Application Server:

Default Serverimonitorsme 0]

honitorserverimonitors e

cancel

Server Group:

- Select MonitorServer(<ServerName>) from the Application Server
list and click OK.

- Select Web Monitor from the Module column in the Selecting
Application Server screen

- Click Select Server. The Select a Server or Server Group dialog box

appears.
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- Select MonitorServer(<ServerName>) from the Application Server
list and click OK.

- Click Next in the Selecting Application Server screen.

12. In the Completing Application Installation Wizard screen, click
Finish.

"& Install Enterprise Application Wizard

Completing the Application Installation Wizard
Confirm the Infarmation for installing the application or modula

&l The application or modula will be instalied with the setings you provided. To make
.| i] changes to these settings, click Back To Install the application, click Finish.

[This application will be installed on the Tollowing nodes with the install direciory satling for
each node as:
moniorsnT ChlbmiwebSphersdppBerveninstaliedAppsiBPM_Monitor ear

of which monitorsn ks the local node. This wizard will autormatically create the instail
diraciony for this local node afar finkshing the Install task

Help < Hack | I I| Flnigh ] Cancel

The Deploy dialog box appears.
T x

Deployed module lecation: |C AibmivebSphare\appServaninstallableAppsimonitor_de

Working Directory: [CuiBrwebSphersappSermeinstalabledpps
Dependent classpath: [

[ Code generation onh
[~ Werify archive
RMIC oplions: [

Database type: [OBIUCEwAN_vT2 =]
Database nanme: [

Schema nanme: [

0Ok | Cancel |

13. Accept the default values in the Deploy dialog box and click OK. The
new Enterprise Application will be installed.

14. Wait until the confirmation message appears, and then click OK.
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1.1.5 Regenerating Web Server Plug-in

Now you must regenerate the Web Server Plug-in to be adequate with the
installed Enterprise Application. To regenerate the Web Server Plug-in:

1. In the WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> and select Regen Webserver Plugin from the shortcut
menu that appears.

= wehSphere Administrative Domain -

----- £3 wirtual Hosts |
----- £ Serer Groups (2 Ger
EH“_'I Modes
=
=B Applica Find...
E} DEf Etl:lp a
gl Mor
L Force Stop 1
- Restart
----- 3 Generii
(=82 Enterprise App Stap for restart
E}ﬂ, manitors Fing
----- £3 EJB Mo T
L £ Web M race...
...3 == medenWebserver Plugin

=+ Resources
EH:'_'I JOBC Proy F'I'EIFIEI"“ES

[l T

2. Wait until the confirmation message appears, and then click OK.

1.1.6 Restart the Web Server

Now you should restart the Web Server you have.

Example: If you installed IBM HTTP Server as the Web Server then do the
following:

1. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Stop IBM HTTP Server.

2. Wait until the confirmation message that tells you that the IBM HTTP
Server has been stopped.

3. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Start IBM HTTP Server.

4. Wait until the confirmation message that tells you that the IBM HTTP

1.1.7  Starting the Monitor Application Server

Now you must start the Monitor Application Server. To do this:

1. In the WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers > > MonitorServer and select
Start from the shortcut menu that appears.
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=9 vwebSphere Administrative Domain &)

----- £3 virtual Hosts B
----- {3 Server Groups B3 Installed”
=B Modes

EI@ monitorsrr
=82 Application Servers
g;. Diefault Server Gensral |;

@ .

..... B Installed Find...
@ nsaes [T
----- {0 Generic Serers
EH“_'I Enterprise Applications

I:_E}---ﬂ maonitarsnt_sample Force Stop
N 2 EJB Modules
(3 Web Modules Remove
[+ BPM Manitar
=83 Resources Create Server Group...
=2 JDBC Providers .
] Froperties

-8 Samnle DA Drive

2. Wait until the confirmation message appears, and then click OK.
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2  WBI Monitor Server Un-
deployment

This section is used in a situation where you would like to completely un-deploy
the Monitor Server. To completely un-deploy the Monitor perform the following
steps:

1. Open the WebSphere Administrator's Console.

2. Inthe WebSphere Administrative Domain tree, right click Nodes >
<ServerName>> > Application Servers > MonitorServer and select
Stop from the shortcut menu that appears to stop the Monitor
Application Server.

=83 WebSphere Administrative Domain <

----- £ virtual Hosts B
----- 3 Server Groups B Installed!
=63 Modes

=6 monitorsmr
=-E2 Application Servers
[F-g) Default Server

General | i

="
=3 Installed _ Find..
~ Installed
----- 2 Generic Eewers
El-f';l Enterpn;e Applications g
El.'ZL monitorsmr_sample ]
- 3 EJB Modules P
I £ weh Modules
[+ BPM Manitor Transactions. ..
=2 Resources
=3 JDBC Praviders ;
. #I7 Samole DB Driv__1oPeMies

3. Inthe WebSphere Administrative Domain tree, right click the
Enterprise Applications > IBM_WBI_Monitor and select Remove
from the shortcut menu.

4. Right click the Nodes > <ServerName>> > Application Servers >
MonitorServer and select Remove from the shortcut menu.

5. Remove all created Data Sources for the Monitor.
Remove the created Database Driver(s).

Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

8. Delete any reference for WBI Monitor from
<WebSphere>\AppServeninstalledApps\

9. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

10. Delete all files in the <Monitor> folder.
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Appendix B: Manual Deployment of
WBI Monitor on
WebSphere 5.0

This appendix describes the manual steps of deploying WBI Monitor on IBM
WebSphere 5.0 Before starting these steps, it is assumed that the Monitor
Database (and Event Queue Database if you are using MQ Workflow as your
engine) with the required Table Spaces are created and configured in your
Database Server. The following conventions are used for all the instructions
throughout this document:

* <WebSphere> = The WebSphere home directory. e.g. C:\Websphere

* <MQ@> = The MQ Workflow home directory. (e.g. c:\fmcwinnt on Windows
platform, /user/fmc on AIX platform, or /opt/fmc on Solaris platform)

* <DB2> = The DB2 home directory. e.g. c:\sqllib

» <Oracle> = The Oracle home directory on the Oracle Server machine (if
Oracle is not running on the same machine on which the IBM WebSphere
Application Server is installed). e.g. C:\oracle\ora81 (Local) or
\\oracle_machine\oracle\ora81 (Network)

» <Monitor> = The Monitor installation directory where the WBI Monitor has
been installed. e.g. C:\WBIMonitor

+ <WebServerName> = The name of the machine that hosts the Web
server for which the WebSphere is configured. (Ex. The machine name on
which the IBM HTTP Server or Microsoft IS 4.0 or 1IS 5.0 is installed)

» <ServerName> = The name of the server on which the Monitor will be
installed.

Important Notes:

* On AlX and Solaris platforms, use forward slash / instead of back-slash \
when writing paths.

» The names and paths of folders and files are case sensitive.

» Make sure that the user you are using have all needed permissions. For
example, using a user who has no permissions on WebSphere or the
Database will fail to deploy the monitor.

* On AlX 5.1 platform, the environment variable named LIBPATH must be
appended with the following pathes: <MQ>//ib and <MQ>/lib/mqserver. To
do this, type The following command in the console window from which
you will start the WebSphere and then press Enter:

export LIBPATH=$LIBPATH:<MQ>/lib:<MQ>/lib/mqserver

© Copyright IBM Corp. 2002, 2003 101



» The Monitor will not work if the server properties client.encoding.override
or default.client.encoding are set to any encoding other than UTF-8.
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1 WBI Monitor Deployment

1.1  Configure IBM WebSphere

The manual deployment of WBI Monitor on WebSphere 5.0 is done through the
IBM WebSphere Administrative Console for either WebSphere Application
Server v5.0 or WebSphere Deployment Manager (Network Deployment) v5.0.
The differences between the deployment steps on each of these WebSphere
editions are:

L]

L]

If you intend to deploy the WBI Monitor on WebSphere Deployment
Manager (Network Deployment) v5.0 then you have to create a new
Application Server (for example, named MonitorServer) on which the WBI
Monitor Enterprise Application will be deployed. Also you have to select
the node on which you will create the Application Sever and deploy the
WBI Monitor Enterprise Application. This is done at the beginning of each
section steps that requires the node selection.

If you intend to deploy the WBI Monitor on WebSphere Application Server
v5.0 then the WBI Monitor enterprise application should be deployed on
the Default Server (server1). And in this case you don't need to create a
new Application Server.

The following sections provide the detailed steps of the manual deployment of

WBI

Monitor on WebSphere.

1.1.1 Create JDBC Providers and Data Sources

[z%_| If previous drivers are already created and installed, then you can
4 skip the following steps for creating and installing the database

drivers for the data source.

You need to create the required Database Drivers and their Data Sources. The
creation of the Database Drivers and their Data Sources should be performed
as the following sequence:

1.

© Copyright IBM Corp. 2002, 2003

If you are not using IBM MQ Workflow as your engine or if the Monitor
database and the Event Queue database are located in the same
physical database:

- Create and install only one Pool Database Driver.

- Create only one Pool Data Sources under the created Pool Database
Driver points to the Monitor database.

If the Monitor database and the Event Queue database are located in
two physical databases:

- Create and install one Pool Database Driver.
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- Create two Pool Data Sources under the created Pool Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

- Create and install one XA Database Driver.

- Create two XA Data Sources under the created XA Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

The following tables provide the required values for the each Database Driver
and Data Source as you should enter through the creation steps:

For Monitor Pool JDBC Provider

Property/Field Name DB2 Oracle

Type DB2 JDBC Provider Oracle JDBC Thin Driver
Name MonitorDB2PoolDrive MonitorOraclePoolDrive
Database JDBC Driver File Name | db2java.zip classes12.zip

Database JDBC Driver File path <DB2>\java12\ <Oracle>\jdbc\lib

For Monitor Pool Data Source

Property/Field Name Value

Name Monitor_Pool_DataSource

JNDI Name MonitorPoolDataSource

For Event Queue Pool Data Source

Property/Field Name Value

Name Event_Queue_Pool_DataSource

JNDI Name EventQueuePoolDataSource

For Monitor XA JDBC Provider

Property/Field Name DB2 Oracle

Type DB2 JDBC Provider (XA) Oracle JDBC Thin Driver (XA)
Name MonitorDB2XADrive MonitorOracleXADrive
Database JDBC Driver File Name db2java.zip classes12.zip

Database JDBC Driver File path <DB2>\java12\ <Oracle>\jdbc\lib

For Monitor XA Data Source

Property/Field Name | Value

104

Name

Monitor_XA_DataSource

JNDI Name

MonitorXADataSource
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For Event Queue XA Data Source

Property/Field Value

Name

Name Event_Queue_XA_DataSource
JNDI Name EventQueueXADataSource

The following sections describe the required steps that you should follow to
create and install a Database Driver and to create a Data Source under this

driver:

Creating and Installing a JDBC Provider

To create and install a JDBC Provider:

1. From the left hand tree, select Resources > JDBC Providers. The
JDBC Provider page appears in the right side of the window.
T, : s —
Bome | Saws | Prelscenies | Loges | Welp | — (4]
— JOBE Providers
Anairry
DO provaiery e uned by T nptebed spploafong 19 Booes date o galsbaney (]
B Servan
B Apgixafars
B Fetowrces: Tokad 0
£ N B Soom Colubaing Finie sl

Pl Lt O o Aimemy  Lipe poome peSng 1o B e wemlabilty Gf resourees By & pArBCUSN Col rade, o Tares

AL MG b Wi Fare Bany e creabed m T e view Fay el b crasied vl Fa el ooge

drmtilipteme My B i fip—

ek Provery PR —

Exspurce Eevrproment Provider

(L Fraders Apply

Bbingris Laghe
B Securty & faw
B Do Bl Pateencen
[ Lyterm Ldrrateston &I Gl
[T P st N

I e = [ ——
Ihllt:-'\-e
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2. Click New. The JDBC Provider > New page appears.

‘seme | Swe | Metsonien | Logesn | el

Wty W e

Aaiviy

B S

[ ppicaforg
B Fstosces
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DB2 JOBC Provider [XA)

Crtonn |
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|
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3. Select the JDBC Driver type from the JDBC Providers drop down list:
4. Click Apply, the configuration page of the selected JDBC Provider type
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5. Type JDBC Provider name in the Name box.
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Type a description for the new JDBC Provider in the Description box
(Optional)

In the Classpath box, change the contents of this field to contain the

path and name of the JDBC Driver file according to your Database
Server type.

Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

10. Click Save.

Creating the Data Source

To create a Data Source to point to a Database and a Communication Driver
under the created JDBC Provider:

1.

Bume | Save | Frelecences | Logest | Melp |

From the left hand tree, select Resources > JDBC Providers. The
JDBC Providers page appears on the right.

From the Existing JDBC Provider list, click the Hyperlink of the JDBC

Provider you have created. The configuration page of the JDBC
Provider appears.

From the Additional Properties section, click the Data Sources
(Version 4) hyperlink. The Data Sources (Version 4) page appears.
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4. Click New. The Configuration page of the new Data Source appears.
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Type Data Source name in the Name box.
Type Data Source JNDI name in the JNDI name box.
In the Database Name field:

- For DB2 database: Type the name of the database to which the data
source points (For example WFMDB for Monitor database or FMCDB
for MQ Workflow database. If you created the Monitor Database or the
Event Queue Database with a different name, then you should type
this name in the Database Name field.).

- For Oracle database: Leave this field empty

8. Type the Database Administrator's user name and password in the
Default User ID and Default Password fields.

9. Click Apply.
10. For Oracle database only:

- In the Additional Properties section that appears in the bottom of the
page:

* Click the Custom Properties hyperlink. The Custom Properties
Page appears.
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* In the Custom Properties page click the URL property hyperlink.
The URL Properties page appears.
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* In the Value field type:
jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:>:<DatabaseName>

Where <Oracle_Server_Name> is the name or the IP address of the
Oracle Database Server machine, <Oracle_Server_Port_Number> is
the Oracle Server Port Number (the default port is 1521) and
<DatabaseName> is the database name (for example WFMDB for
Monitor database or FMCDB for MQ Workflow database. If you
created the Monitor Database or the Event Queue Database with a

different name, then you should type this name in the Database Name
field.).

* Click Apply.
- Click OK

- Click Save in the top menu bar to save your changes. The Save page
appears.

- Click Save.

11.2 Create a new Shared Library

1. In the left hand tree expand the Environment node

2. Select the Shared Library hyperlink. The Shared Libraries page
appears.
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3. Click New. The configuration page of the new Shared Library appears.
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4. Type MQLib in the Name box.

5. Type a description for the new shared library in the Description box
(Optional).
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- In the Classpath box, enter the path of the file fmcojagt.jar file (the
default location is under the <MQ>\bin\java3320 folder

Click OK

Click Save in the top menu bar to save your changes. The Save page
appears.

8. Click Save.

1.1.3 Create a new Application Server

The following steps describe how to create a new Application Server named
MonitorServer, on which you will deploy the WBI Monitor Enterprise Application
in case of deploying on WebSphere Deployment Manager (Network
Deployment) v5.0. Do not create this new Application Server if you are going to
deploy the WBI Monitor Enterprise Application on the Default Server (server1)
in case you are deploying on WebSphere Application Server 5.0.

To create a new Application Server for WBI Monitor:
1. From the Left hand tree, expand the Servers node.

2. Click the Application Servers hyperlink. The Application Servers
page appears.
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3. Click New. The Create New Application Server wizard appears.
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4. Select the node on which the new Application Server will be created
from the Select Node drop down list.

Type MonitorServer in the Server name field.
Leave the other fields with their default values.

Click Next. The Confirmation Page appears.

© N o o

Click Finish. The new Application Server will be created and its name
will be added to the Application Servers list in the Application
Servers page.

9. Click Save in the top menu bar to save your changes. The Save page
appears.

10. Click Save.

11.4  Configure the New Application Server

After creating the MonitorServer Application Server, you need to configure its
parameters. If you intend to deploy the WBI Monitor Enterprise Application on
the default Application Server (Default Server) named server1, then adjust this
Application Server with the different settings.

To configure the Default Server (server1):
1. From the Left hand tree, expand the Servers node.

2. Click the Application Servers hyperlink. The Application Servers
page appears.
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6.

Click the server1 hyperlink in the Application Servers list. The server1
Configuration Page appears.

Click the Process Definition hyperlink. The Process Definition
configuration page appears.

- Click the Java Virtual Machine hyperlink. The Java Virtual Machine
configuration page appears.

* In the Initial java heap size box, type 64
* In the Maximum java heap size box, type 128
* Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.

To configure the MonitorServer:

1.
2.

From the Left hand tree, expand the Servers node.

Click the Application Servers hyperlink. The Application Servers
page appears.

Click the MonitorServer hyperlink in the Application Servers list. The
MonitorServer Application Server Configuration Page appears.

Click the Process Definition hyperlink. The Process Definition
configuration page appears.

- In the Working Directory box, type <Monitor>
- Leave the other fields with their default values.
- Click Apply.

- Click the Java Virtual Machine hyperlink. The Java Virtual Machine
configuration page appears.

* In the Initial java heap size box, type 64
* In the Maximum java heap size box, type 128
* Click OK.

- Click the MonitorServer hyperlink in the top of the page to return to
the MonitorServer Configuration Page.

- Click the Logging and Tracing hyperlink. The Logging and Tracing
configuration page appears.

- Click the JVM Logs hyperlink. The JVM Logs Configuration Page
appears.

* In the System.out section change the value in the File Name field
to contain the following: <Monitor>/logs/ stdout.log

* In the System.err section change the value in the File Name field
to contain the following: <Monitor>/logs/ stderr.log

* Click OK.
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5.

6.

1.1.5

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.

Configure the Virtual Host

Now you should configure the default_host virtual host in order to add the
server HTTP port to its Host Aliases list.

These steps are done only if you have created a new Application Server in case
of Network Deployment. If you will deploy the WBI Monitor Enterprise
Application on the Default Server (server1) then do not perform these steps.

To configure the Virtual Host:

1.
2.

© © N o

1.

12.
13.
14.

15.
16.

17.

In the left hand tree, expand the Servers node.

Click the Application Servers hyperlink. The Application Servers
page appears.

Click the MonitorServer hyperlink. The MonitorServer configuration
page appears.

Click the Web Container hyperlink from the Additional Properties
table. The Web Container page appears.

Click the HTTP Transports hyperlink from the Additional Properties
table. The HTTP Transports page appears.

Click the * hyperlink in the First row of the HTTP Transports table.
Copy the value in the Port field.
In the left hand tree, expand the Environment node.

Click the Virtual Hosts hyperlink. The Virtual Hosts configuration page
appears.

Click the default_host hyperlink in the hosts list. The default_host
configuration page appears.

Click the Host Aliases hyperlink in the Additional Properties table.
The Host Aliases page appears.

Click New. The Configuration page of the new Host Alias appears.
Type * in the Host Name field

Type the MonitorServer HTTP Port Number that you’ve copied in the
Port field.

Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.
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1.1.6  Configure the WBI Monitor Initial Parameters

Now you should configure the WBI Monitor initial parameters. This is done
through the WebSphere Application Assembly Tool.

To configure the WBI Monitor initial parameters:
1. Start the WebSphere Application Assembly Tool.
Click Cancel to close the welcome screen.
Select File> Open from the menu. The Open dialog box appears.
Select the monitor.ear file located under <Monitor>\servenserver.

Expand the tree on the left.

o gk w D

Add the required environment entries (parameters) in the Environment
Entries node under the session bean of the following modules:

- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the WICS_Connector_ID module
* WICSConnector bean.
- For the Connector_ID module.
* MQWFConnector bean.
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The following table lists the required parameters that should be entered for each
session bean.

Property Name / EJB Name:

< | NotificationAgent
< | WMQIConnector
< | WICSConnector

<« | ClientAgent
<« | CleanupAgent

< | EventProcessor
< | DBBridge

monitor.db.schema

< | < | MQWFConnector

monitor.db.eqSchema

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modelindexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

RN IR RN AN BN BN NV RN

monitor.db.tablespaces.processDataTables
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monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalLob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDataLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

monitor.db.tablespaces.mbDetailLob

NI I AN AR N AN B N BN B NE RN

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqlndexes

monitor.db.tablespaces.conDetailDataLob

monitor.db.tablespaces.defaultTablespace

IR ERNE RN

monitor.wmqi.enabled

monitor.wics.enabled

monitor.mqwf.enabled

monitor.security.mode

monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

monitor.mqwf.locator

monitor.mqwf.agent

monitor.mqwf.system

monitor.mqwf.sysGroup

S IR NS N BN BN BN BN N AN RN

SESSS

monitor.mqwf.encoding

v

The following table provides the description of each parameter.

Parameter Name Type | Value Description

monitor.db.schema String | The Monitor Database Schema. The default value is WFM

monitor.db.eqSchema String | The MQSeries Workflow Database (Event Queue Database)
Schema. The default value is FMC
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monitor.mqwf.enabled

String

Type True if you are using MQ Workflow as your engine or False
otherwise.

monitor.wmgi.enabled String | Type True if you are using WMQI as your engine or False
otherwise.

monitor.wics.enabled String | Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode String | The applied security mode:
» Type MQ for MQ Workflow security mode if you are using MQ

Workflow as your engine.
» Type LDAP for LDAP security mode or Local for local security
mode if you are only using WMAQI as your engine.

monitor.security.ldap.url String | The LDAP Server URL and port number (for example Idap://
Idapsrvr:389/).
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn String | A Distinguished Name (DN) for an LDAP Server authorized user
that will be used for logging in to this LDAP Server, and perform-
ing the search in the LDAP users' tree.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.password String | The password of the defined User DN.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.naming.attr | String | The name of the prefix that precedes the user ID in the LDAP
Server database (i.e. CN, UID,...etc). The value of this parameter
varies between the different types of LDAP Servers.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.root String | The starting point in the LDAP tree from which the query will start
searching for the full DN of the given user ID.
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn.attr.id String | The name of the Distinguished Name attribute ID (for example
distinguishedName, entrydn ...etc. This value is case sensitive).
This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.mqwf.locator String | The MQSeries Workflow Locator Policy that is used to locate the
MQSeries Workflow Java Agent. This property can have one of
the following values: LOC, RMI, OSA, IOR, COS, or JNDI. The
default value is LOC (Local Locator Policy)

monitor.mqwf.agent String | The MQSeries Workflow Agent's Name

monitor.mqwf.system String | The MQSeries Workflow System's Name

monitor.mqwf.sysGroup String | The MQSeries Workflow System Group's Name

monitor.mqwf.encoding String | The MQSeries Workflow Database encoding. (This property must

be set if the MQ Workflow Database encoding is different from the
Monitor Server machine encoding)
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In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define
this property then the database user default TableSpace will be used as
the default TableSpace..

Parameter Name

Type | Value Description

monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database

Administration tables.

monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database

Administration indexes.

monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static
model tables.
monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static

model indexes.

monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database

Dynamic tables.

monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database

Dynamic indexes.

monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database

Security tables.

monitor.db.tablespaces.securitylndexes String | TableSpace name of the Monitor Database

Security indexes.
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monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.
monitor.db.tablespaces.processDatal.ob String | TableSpace name of the Monitor Database
Process Data LOB.
monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.
monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.
monitor.db.tablespaces.eventDatal ob String | TableSpace name of the Monitor Database Event
Data LOB.
monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.
monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.
monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .
monitor.db.tablespaces.eqlndexes String | TableSpace name of the MQSeries Workflow
Database Event Queue indexes.
monitor.db.tablespaces.conDetailDatal.ob String | TableSpace name of the MQSeries Workflow
Database Configuration Detail Data LOB
monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used

for any tables or indexes category that has not
been assigned to a specific TableSpace.

B Important Note: In Oracle Database, the Event Queue database
schema and the Monitor Database Schema must be the same as

the Database Administrator's User Name.

different configuration.

[z%_[ Important Note: In MQ Workflow, a default configuration must be
defined even if the entered System Group and System belong to a

To add each one of these parameters, do the following:
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- Right click inside the right-hand table, and select New from the shortcut
menu that appears. The New Environment Entry dialog box appears.

x|
General |
Ervironmeant entries define vaniables used fo customize the business logic for an

Walug:

Type:

application.
Mama: |

“ISl;lu'u:]

1.1.7

Dascription

ok | moy | cancal | Hew

- Type the parameter name in the Name field.

- Type the parameter value in the Value field.

- Select the parameter type from the Type drop down list.

- Click OK. The new parameter will be added to the table.

Select File > Save from the menu to save the monitor.ear.

Exit the Application Assembly Tool.

Install the WBI Monitor Enterprise Application

Now you will create and install an Enterprise Application for WBI Monitor.

1.
2.
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From the left hand tree, expand the Applications node.

Click the New Enterprise Application hyperlink. The Preparing for the
application installation wizard first page appears.

Click the Browse button to locate the monitor.ear file. The Open dialog
box appears.

- Select the monitor.ear file located in server folder.
- Click Open. The file will be selected.

In the second step of the Preparing for the application installation
wizard, select the Generate Default Binding check box

Click Next. The Install New Application wizard will start on its first
step’s page:
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- In the Directory to Install Application field, enter the directory you
want to be used for installing the WBI Monitor Enterprise Application. If
you leave this field empty, then the default directory that the IBM
WebSphere Application Server used for installing the applications will
be used (i.e. C:\WebSphere\ApplicationServeninstalledApps).

- Select the Deploy EJBs check box.

- Leave the other settings with the default values.

- Click Next.

For the Steps 2 to 4 in the wizard, click Next without changing any

parameters.

In step 5 page (Mapping Resource References to Resources) do the

following:

- If the Monitor database and the Event Queue database are located in
the same physical database (one database), then all resource
references are mapped to the same physical data source named
Monitor_Pool_DataSource.

- If the Monitor database and the Event Queue database are located in
two physical databases, then map each resource reference to the
appropriate resource according to the following table:

PoolEventQueueDataSource

EJB Resource Ref. Data Source Name Data Source JNDI Name
ClientAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
CleanupAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
EventProcessor jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
NotificationAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
MQWFConnector jdbc/MonitorDataSource Monitor_XA_DataSource MonitorXADataSource
MQWFConnector jdbc/EventQueueDataSource Event_Queue_XA_DataSource EventQueueXADataSource
MQWFConnector jdbc/ Event_Queue_Pool_DataSource | EventQueuePoolDataSource

WMaQIConnector

jdbc/MonitorDataSource

Monitor_Pool_DataSource

MonitorPoolDataSource

122

To perform the mapping:

- Select the Reference(s) you want to map to a specific resource (data
source) by selecting the check box in its row in the table.

- Select the appropriate resource (Data Source) from the Specify

existing Resource JNDI name drop down list.

- Click Apply. The selected resource will be mapped to all selected
references, and its name will appear in the JNDI Name column's cells

for these references.

For Step 6 in the wizard, click Next without changing any parameters.

In the Step 7 page (Map modules to application servers) do the

following:
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10.
1.

12.
13.

1.1.8

- Select the Application Server on which you want to deploy the WBI
Monitor Enterprise Application from the Clusters and Servers list.

- Select the check box next to the Module column header to select all
existing modules (Monitor, MonitorService, and MonitorClient).

- Click Apply.
- Click Next.
In the Steps 8, click next without changing any parameters.

In Step 9 (Summary) the settings you have chosen will be listed.
Review these settings. To return to any previous step, click the step
number hyperlink and or click Finish if all settings are correct.

Wait until the installation is finished and the confirmation page appears

Click Save to Master Configuration hyperlink to save your
configuration. Then click Save in the confirmation message.

Assign the Created Shared Library to the Installed
Enterprise Application

Now you should assign the MQLib shared library that you have created before
to the WBI Monitor Enterprise Application that you have just installed. To do

this:
1.

In the left hand tree, expand the Applications node.

2. Click the Enterprise Applications hyperlink. The Enterprise

Heme | Seve | Frolecenies | Logesm | Help |

Applications page appears.
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3. Click the IBM_WBI_Monitor hyperlink (or the name of the installed
Enterprise Application of the WBI Monitor if you have changed the
default name). The IBM_WBI_Monitor Configuration Page appears.
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4. Click the Libraries hyperlink from the Additional Properties table. The

Library Ref page appears.

5. Click Add. The Configuration page of the new Shared Library

Reference appears.
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6. Select the MQLib shared library from the Library Name drop down list.
Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

9. Click Save.

1.1.9 Regenerate Web Server Plug-in

Now you must regenerate the Web Server Plug-in to be adequate with the
installed Enterprise Application. To regenerate the Web Server Plug-in:
1. In the left hand tree, expand the Environment node.

2. Click the Update the Web Server Plugin hyperlink. The Update web
server plugin configuration page appears.
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3. Click OK.

1.1.10 Restart the Web Server

Now you should restart the Web Server you have.

Example: If you installed IBM HTTP Server as the Web Server then do the
following:

1. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server 1.3.26 > Stop IBM HTTP Server.

2. Wait until the confirmation message that tells you that the IBM HTTP
Server has been stopped.
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From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Start IBM HTTP Server.

Wait until the confirmation message that tells you that the IBM HTTP
Server has been started.

1.1.11 Start the Application Server and the Enterprise

Application

For IBM WebSphere Application Server v5.0

You must restart the Default Server (server1) after you deployed the WBI
Monitor new Application Server. To do this:

1.

On Windows platform, run a command prompt window. On AIX or
Solaris platforms start a terminal console window.

Change the directory to <WebSphere>\bin
Type the following command line:

stopserver server1

This command is case sensitive.

Wait until the Application Server is stopped and the confirmation
message appears, and then type the following command line:

startserver server1

Wait until the Application Server is started and the confirmation
message appears.

For IBM WebSphere Deployment Manager (Network
Deployment) v5.0

From the Administrative Console, do the following:
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1. From the left hand tree, select Servers > Application Servers. The
Application Servers page appears.
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2. Select the MonitorServer Application Server by selecting the check box
next to the Application Server's name.

2%, | If you have created the application server with a different name or
you have deployed the Monitor Enterprise Application on a
different Application Server then select it from the list.

3. Click Start.
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2  WBI Monitor Server Un-
deployment

This section is used to completely remove the WBI Monitor Application Server.
To completely remove the WBI Monitor, perform the following steps:

1. Open the WebSphere Administrative Console.

2. Uninstall the WBI Monitor Enterprise Application (the default name is
IBM_WBI_Monitor).

- From the left hand tree, select Applications > Enterprise Applications.

- Select the check box next to the IBM_WBI_Monitor Enterprise
Application name.

- Click Stop.

- Select the IBM_WBI_Monitor Enterprise Application again.

- Click Uninstall.

Delete the HTTP Port that you have added to the Host Aliases list.

Delete the MonitorServer Application Server.

(5, If you have deployed the WBI Monitor Enterprise Application on
B the Default Server named server1, then do not perform the above
two steps (3 and 4).

Delete the added MQLib shared library.
Delete the added JDBC Providers.

Save your changes.

® N o o

Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

9. Delete any reference for WBI Monitor from
<WebSphere>\AppServeninstalledApps\

10. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

[z&_| This directory does not exist if you have deployed the WBI Monitor
4 Application Server on the default (base) Application Server named
serveri

11. Restart the WebSphere Application Server.
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Appendix C: IBM DB2 7.2 Database

Server Configuration

This chapter provides detailed steps about configuring your database server by
creating the Monitor database and configuring both the Monitor database and
the Event Queue database (the IBM MQSeries Workflow or the IBM
WebSphere MQ Workflow database) using IBM DB2 UDB 7.2 with fixpack 5 on
Windows platform.

1 Creating the Monitor Database

To create the Monitor database

1.
2.

Open DB2 Control Center.

Create a new Database (No specific name is required, but IBM WBI
Monitor recommends WFMDB as the Monitor database name).

- Expand the tree in the left tree browser until you reach the Databases
node.

- Right-click the Databases node and select Create > Database Using
Wizard from the shortcut menu to create the database. The Create
Database dialog box opens.

- Type WFMDB in the Database Name text box, and WFMDB in the
Alias text box

- Click Finish

Configure the created database by adjusting the following configuration
settings:

- Right-click the WFMDB and select Configure from the shortcut menu.
- In the Configure Database dialog box, select the Performance tab.

- Scroll the Parameters grid and change the values of the following
parameters to these values:

* Maximum Storage for Lock list: 50000
* Application Heap Size: 4096
* Application Control Heap Size: 4096

- Select the Application tab and change the value of the following
parameter:

* Maximum Lock per application: 50
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- Click OK. And then reconnect to the database.

B If the Monitor was running, you have to restart it once again in
B order to use the new database settings.

4. If one of the business processes in the organization file (.org) contains
more than 55 business measures, you should calculate the page size by
performing the following steps:

- From the .org file, calculate the maximum number of business
measures in any process of the model

- Divide the calculated number by 55

- Round the result number up to the nearest integral value. (e.g. if the
result is 1.3 then the you should round it up to 2)

- Multiply the last value by 4K.

- Round the result up to the nearest value of 8K, 16K, 32K, etc. This will
be the required page size. (E.g. if the result is 12K, then the required
page size is 16K)

2 Creating the Buffer Pool

Create a Buffer Pool named HFXBP with the calculated page size:

1. Open IBM DB2 Control Center
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2. Expand Databases > WFMDB
3. Right click Bufferpools and select Create from the shortcut menu

4. In the Create Buffer Pool dialog box, do the following:
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- For the Buffer Pool field, type the name of the Buffer Pool (No specific
name is required, but IBM WBI Monitor recommends HFXBP as the
Buffer Pool name).

- In the Page Size combo box select a number that equal to the

calculated page size you calculated in the previous steps, then click
OK.

x

MOMITORSEYR - DE - We MDB

Buiffir posd| namie :

Fapge size |-1 - |
Size in 4 KB pages | 250

[ Use estended storage
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5. Restart the DB2 or Restart the computer

3  Creating the TableSpaces for
EventQueue and Monitor
Databases

1. In WFMDB database, create a new table space with the calculated page
size (No specific name is required, but IBM WBI Monitor recommends
HFX as the tablespace name).

You can create the TableSpace with a different name; in this case
o you should keep in mind to use this name instead of the “HFX”
name in any other deployment steps that refer to the Monitor
TableSpace name.

The following steps describe how to create the HFX table space:
- Open the IBM DB2 Control Center again
- Expand Databases > WFMDB

- Right click Table Spaces and select Create from the shortcut menu,
then select Table Space from the sub menu. (Don'’t select Table
Space Using Wizard)

- In the Create Table Space dialog box do the following
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* In the Table Space Name text box type HFX
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* Click Add
* In the Add Container dialog box:
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- In the Container Name text box, type the container name

- In the Current Directory text box, type the container current
directory or select the directory path, then click OK.

* Click Advanced

132 IBM WBI Monitor - Deployment Guide



* In the Advanced dialog box:

x
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- In the Page Size combo box select a number that equal to the
calculated page size you calculated before.

- In the BufferPool field, select HFXBP
- Click OK

* Click OK to create the Table Space and to close the Create Table
Space dialog box

2. In the MQ Workflow database (e.g. FMCDB), create a new table space
(No specific name is required, but IBM WBI Monitor recommends HFX
as the tablespace name).

[z%_| You can create the TableSpace with a different name; in this case

Sy you should keep in mind to use this name instead of the “HFX”
name in any other deployment steps that refer to the EventQueue
TableSpace name.

- In the IBM DB2 Control Center, Expand Databases > FMCDB

- Right click Table Spaces and select Create from the shortcut menu,
then select Table Space from the sub menu. (Don't select Table
Space Using Wizard)

- In the Create Table Space dialog box do the following
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* In the Table Space Name text box type HFX

I8 Create Table Space

X|
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* Click Add
* In the Add Container dialog box:
™ Add Container x|
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|FMCDBContainer
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Drives
C: | 4276 MB available
]9 Cancel Apply Help
- In the Container Name text box, type the container name
134

IBM WBI Monitor - Deployment Guide



- In the Current Directory text box, type the container current
directory or select the directory path, then click OK.

* Click OK to create the Table Space and to close the Create Table
Space dialog box

The value of the page size of the table space of the MQ Workflow
4 database is not affected by the number of business measures in
the organization file processes.

Make sure that IBM DB2 Server is configured for JDK 1.2 or higher.
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Appendix D: Controlling the Logging
Service in IBM WBI
Monitor v4.2.4

IBM WebSphere Business Integration (WBI) Monitor provides you with the
capability of logging all the messages that are transacted at run time in its
various components. You can control the Logging service to log only specific
types of messages, or to log all types of messages that are associated with one
or more function areas (components) of the application.

The ability to control the logging service manifests significant importance as it
limits the amount, and type, of the data that is saved to the WBI Monitor log file.
This remarkably enables the user, and thus customer support team members,
to trace source of a particular problem more easily by limiting the logging of
messages to only those pertaining to the parts of the application in which
problems take place. Hence, this eliminates the need for analyzing and scrolling
down unneeded messages (e.g. Error, Warning...etc) that may exist in a
conventional stretched log file.

The produced WBI Monitor log files are mainly stderr.txt and stdout.txt. In
case of WAS 4.0, they could be found in the folder named Logs that resides in
the directory on which you have deployed the WBI Monitor. In case of WAS 5.0,
they could be found in the folder named Logs that resides in the root
WebSphere directory.

The control of logging service is implemented through the definition of one or
more categories and/or detail Level in the Java Virtual Machine tab in WAS
4.0.2, or WAS 5.0.
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1.1

1.2
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b

b

Message Logging/Tracing

The logging service is controlled through two system properties. These two
properties are: (Detail) Levels, and Categories.

The first system property (Levels) enables the logging of messages based on
defined (detail) Levels. Each level is an integer value that represents one or
more types of messages to be logged. The second system property
(Categories) enables logging all debug messages related to one or more
function areas (categories) that you specify in a comma-separated parameter
on WAS 4.0, or WAS 5.0.

Levels

You can setup the logging service to log messages or errors depending on the
level you specify. The level of details to be saved to the log file is defined by
specifying the appropriate integer value from the following table:

Level Description

1 This level enables logging Fatal Error messages.
2 This level enables logging Error messages.

3 This level enables logging Warning messages.

4 This level enables logging Debug messages.

Categories

When you specify a category in the logging service, you enable the logging of
all the debugging messages that are related to this category. In case of
specifying multiple categories, at least one comma must separate between
every two successive category names.

For example ADMIN,IMPORT,,,SECURITY,,," is valid a value, and implies that
you enables the logging of the debug messages for these three categories.

Any values that you type other than those listed in the following
table will be ignored.

For categories to be active, you have to use detail Level 4.

The following table depicts the function areas (categories) whose debug
messages can be logged in the WBI Monitor log file.
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Category

Description

ALL It means that all categories will be logged.
NONE It means that no category will be logged.
IMPORT It means logging messages concerning the import of model, and the export of

actual values.

EVENT_PROCESSING

It means logging messages concerning the module handling MQ Workflow
events and calling appropriate monitor engine functions.

EVENT_COLLECTOR

It means logging messages concerning module handling the retrieval of audit
trails events and process data from MQ Workflow.

MONITOR_ENGINE

It means logging messages concerning module handling the event processor
commands to store appropriate data in monitor database.

BUSSINESS_ENGINE

It means logging messages concerning the calculation of business measures at
the appropriate locations, and firing notifications when necessary.

DATABASE It means logging messages concerning database transactions such as
inserting, updating, deleting, or querying data.
SECURITY It means logging messages concerning adding, removing, and updating users,

groups, and users’ & groups’ permissions/constraints, in addition to login and
logout.

ADMIN_MANAGER

It means logging messages concerning suspending, resuming or terminating
process instances. This also includes logging messages related to transferring
work items, creating or dropping database, starting or stopping monitor
services, and starting or stopping event queue.

CONFIGURATION

It means logging messages concerning adding, updating and deleting
configurations and system configurations.

REPORT It means logging messages concerning the handling of the different reports
displayed in the Business Dashboard.

WFD It means logging messages concerning the Workflow Dashboard.

REPOSITORY It means logging messages concerning the retrieval of the model elements (org

units, employees, processes...etc).
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2 Controlling the Logging Service

You can control the logging service in WAS 4.0 or WAS 5.0 by following the
steps below.

21 WAS

1.

22 WAS

140

4.0

Access the Java Virtual Machine page.

- Click WebSphere Administrative Domain > Nodes > NodeName >
Application Servers > server name (whose JVM settings you want to
configure [MonitorServer] in the console navigation tree).

- Select the JVM Settings tab.

On the Java Virtual Machine tab, specify values for the JVM settings as
needed. Specify command-line arguments to pass to the Java virtual
machine code that starts the application server process in a name-value
pairs:

- Click Add to enter an entry in the System Property table.

- Specify name/value pair property: for example type
monitor.debug.level (or monitor.debug.cateogory) in the Name
field, and type the value in the Value field.

- Click Apply to view a page with your new settings.

Restart the application server.

5.0

Access the Java Virtual Machine page.
- Click Servers > Application Servers in the console navigation tree.

- On the Application Server page, click on the name of the server
whose JVM settings you want to configure [server1].

- On the settings page for the selected application server [server1], click
Process Definition.

- On the Process Definition page, click Java Virtual Machine in the
Additional Properties.

On the Java Virtual Machine page, specify values for the JVM settings
as needed.Click Custom Properties in Additional Properties:

- Click New to display the settings page for your internal system
configurations property.

- Specify name/value pair property: type monitor.debug.level (or
monitor.debug.category) in the Name field, and type the value in the
Value field.

- Click Apply to view a page with your new settings.
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- Click OK to return to the Custom Properties page, where your new
property appears in the list.

- Click OK to return to the Java Virtual Machine page.
Click Save on the console taskbar.

Restart the application server.
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Chapter 5: WBI Monitor Deployment
on 0S/390 and z/OS

Platforms

This chapter contains detailed steps for deploying IBM WBI Monitor on IBM
WebSphere Application Server 4.0.1 for 0S/390 and z/OS Platforms. The

following figure illustrates the deployment sequence and the required
environment to perform the deployment.

Workstation $/390 Machine
Q5,280 or 05
TCRIP
Wifin dowus Connection
O |:

Assemhbly Tool for [BM YWebhSphere
Administrators Console

Q8390 and Z0 S
£ 5 £
£ S &
i S
& 3 5 I
g‘:_% %, § Deployment
=28 2 £ Steps |[BM WehSphere
£ = e J  Application Server
g8 v f it
o= = 'C? Deployed honitor
Application Senver
Qriginal mModified
monilor.ear file monror.ear file

The following conventions are used for all the instructions throughout this

document:
* <Monitor> = The Monitor installation directory. e.g. C:\WBIMonitor

+« <WebServerName> = The name of the machine that hosts the Web
server for which the WebSphere is configured.
» <ServerName> = The name of the server on which the Monitor will be

installed.
* <MonitorWebPath> = The monitor web application web path eg. /monitor.
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* <MonitorServiceWebPath> = The monitor web application web path eg. /
monitorservice.

25, Important note: The names and paths of folders and files are case
¥ sensitive.

25, Important note: Make sure that the user you are using have all

B needed permissions. For example, using a user who has no

permissions on WebSphere will fail to deploy the monitor.

[z%_[ The Monitor will not work if the server properties
¥ client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.
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5.1 IBM WBI Monitor Deployment

5.1.1 Configure the Database Server

The first thing you have to do is to configure the Database Server. To do this:
1. Create the Monitor database (i.e. WFMDB)

2. Create the required TableSpaces in both the Monitor Database
(WFMDB) and the EventQueue Database (FMCDB). WBI Monitor
allows you to control the distribution of the Monitor and the EventQueue
Database tables and indexes into a number of TableSpaces that are up
to 22 TableSpaces; 19 of them are created in the Monitor Database and
three of them are created in the EventQueue Database. The database
tables and indices are grouped and categorized so that each category
can be assigned to a separate TableSpace.

This number is the maximum number of TableSpaces to which you can
assign the database tables and indexes. This means you do not have to
create all these TableSpaces, but you can create part of them. In this
case, during the deployment steps, you can assign more than one group
of tables or indices to the same TableSpace.

Please refer to the section named Database Tables and Indexes
Allocation with Multiple TableSpaces in Chapter 3: Database Server
Configuration of this guide for details about the distribution of the Monitor
and EventQueue database tables and indexes on multiple TableSpaces.

3. Adjust the Database authorizations for the User ID that will be used by
the WBI Monitor to access the database. The following are the required
actions on the database that should be used in order to set the needed
permissions for the given User ID:

- DDL actions

* ALTER TABLE

* CREATE TABLE & DROP TABLE

* CREATE TRIGGER & DROP TRIGGER
- DML actions

* SELECT

* INSERT

* UPDATE

* DELETE

* SELECT FROM SYSIBM.SYSTRIGGERS

* SELECT FROM SYSIBM.SYSDUMMY 1

4. Create the Monitor and EventQueue Database Tables by running the
DDL files named monitorCreate.sql and eqCreate.sql respectively.
These files are located in the <Monitor>/server/docs/ddl folder.
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Before running, these files have to be edited in order to update them with
the actual Schema and TableSpace name that you have created in the
database. To do this:

- Open each of these two files in any text editor.

- Replace the variables named $TABLESPACE$ and $SCHEMAS$ with
the actual name of the TableSpace and Schema in each creation
statement of the tables and indexes.

For example:
The original statement is:

CREATE TABLE "$SCHEMAS$"."SCHEMA_HEADER"("VERSION"
INTEGER NOT NULL) IN $TABLESPACE$$

The modified statement should be

CREATE TABLE "WFM"."SCHEMA_HEADER"("VERSION"
INTEGER NOT NULL) IN AdminTablespace$

- Save and close the file.

(24| Important Notes:

* The delimiter used in these files is the Dollar Sign ($). You
must set this delimiter in the command that you will use to
run these files specifically, otherwise the default DB2
delimiter (;) will be used.

* For distributed installation and deployment (where the
Database server is located on a z/OS or an 0S/390 machine
while the WebSphere Application Server is installed and
used from a different Windows, AIX or Solaris machine),
You must make sure that the Database Client is installed on
the client machine where the WebSphere Application Server
is installed,and is properly configured and connected to the
Database Server that exists on the Mainframe. Consult your
database Administrator for information about configuring
the DB2 database client to connect to the remote database.
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5.1.2 Modifying the Monitor Enterprise Archive File

Before starting the deployment of IBM WBI Monitor application server on
WebSphere Application Server, you should first modify the original monitor.ear
file that has been installed on your machine in <Monitor>/server/server using
the manual deployment option in the WBI Monitor installation wizard. This is
important in order to make this file compatible with OS/390 and z/OS operating
systems.

The following sections and their steps describe how to use the Assembly Tool
for z/OS and 0S/390 to modify the monitor.ear file:
5.1.2.1 Importing the Monitor Enterprise Archive File

1. Open the Assembly Tool for z/OS and 0S/390.

2. From the Assembly Tool menu bar, select Selected > Import.

ﬂﬂ.mltauun Assembly Tool for z/05 and 057390 ;.IQJ ﬂ
S HEL J

-

BEOIL048) Initlalzation complete for Application Assambly Tool Tor 2005 and OS380, version AAT 4.00.029, using
Windows 2000

i r

| |

The Import Application dialog box appears.
x

Enter the EAR file path name prefix:

|D:".wEIIMn.nmmM-;eryeﬁsewenmnnitqr |.ear | Choose...

Cancel | ||-|n||:.|
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3. Click Choose. The Select EAR File to Import dialog box appears.

[ Select EAR file to import 35]
Loak in; ||'_'Im "'| @ @ @ Tﬁh
_D moniorear I Archive file contents |
S — “IMETA-INF/IMAMIFEST MF -
ME TA-ENFlapplication xml
META-INFbm-application-bnd ami
META-INFiibm-application- extxmi
jdarm jar
monitarapl jar i
File pame: | monitor gar Lok |
Fies of tyye: | EARfles (.ear) v | cancel |

Locate and select the monitor.ear file from the temporary folder in which
you have placed a copy of it, click OK, and then click OK in the Import

Application dialog box.
The IBM_WBI_Monitor node will be created and displayed under the

Applications tree.

EJ’-IHNIE ation Assembly Tool Tor 205 and 05390 | lu! x|
Fle Selected Build View Edit Fiter Options  Help

AEHS OX #=958 4 X7
Im =
© . Applications |:

@~ |BW_WHEI_Monitor 5

Il = |
' |
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5.1.2.2 Deleting the XMI Files

1. Right-click the IBM_WBI_Monitor node and select Modify from the
shortcut menu that appears.
@ [ Applications
@ |BM_ i
o
Delete
Save
Cancel
¢ Export..
Validate
Deploy
Expand
Collapse
Properties ¥
@ Refresh

Help

2. Select the Files tab on the right.

Dh;u_-lll atian Assemnbly Tooal lor 705 and 055 3590 _-lmzl

P08 | Ganeral cons. Securty fies
® 21 EjbJars Fils
= Conneclor_ID
& Monitor Ralatve palh 1 Mosied [ Sum 1
& WMOH_Connectar_ID METAINFI BIZRIDI 1044 PM [
® 1 WebApps META INFIMANIFEST MF BFZE3 10044 PM 1o7
B Moo lignt WETA-INFiappiscatian xml B A3 1135 A 1,378
& MonsorSerdc b META-INFAbm-appikcation-bnd xmi | BRI 1935 AW [
1 Application Chents META-INF - applic ation-exd xmi B 1D 1135 A B30
o jur B1/03 1138 AW 106416
metamodel jar BIZRAD3 10042 PM 11517
mondoeapd jas BUZEA03 10042 P 168,161
imiondoet liend wars Q2803 10:44 P BA1BETE
imandiore ] _VWebApp far WA 1105 AM 2854
monforsener jar BUZRA03 1043 PM 484678
momhlnidendie wif B3 10043 P 1,252
monforsendce_WebApp jar SRR 1105 AM 1858
migeeic cnneclor jar BUZE/03 10043 PM 19618
SSCUiAr BIZRM03 1040 PM Af2545 =
| Wmpori- | | Dewte | | Vew. | | Bdrsct. | | (00
o e i
BBOSA04E! InSalzaton complete for Applicalion Assermbly Toal for 08 and 0S80, version AAT 4 00,032, using Wendows 2000
BECINSI Application B _WEI_Monfior was dililed
BROS40011 Agplic sticn iEM_WBI_Monfior wis impavied from Bile D05 3SNR alieghiSoure e6i8- 18- 0 Armonitor aar

|

| J

MWW Monfion: Mot emodified

3. From the Files list, select each file that has .xmi extension (2 files), and

then click Delete for each selected file.
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4. Right-click the IBM_WBI_Monitor node and select Save from the
shortcut menu.

B Applications
© [BM_WEI_Monkor

Q Elfn J3
® Conng
I__'_a-l-'—
¢ Cancel
@ Monfo |
*
Properties *
@ Wma |

5. Repeat the above steps for the Connector_ID, Monitor, and
WMQI_Connector_ID nodes under the IBM_WBI Monitor>EJB Jars
node, and for the MonitorClient and MonitorService nodes under the
IBM_WBI Monitor>Web Apps node to delete all files that have the
extension .xmi from their files list.

5.1.2.3 Modifying the Session Beans

1. Expand the Applications tree

2. Do the following for each session bean of the following EJB modules
under IBM_WBI_Monitor \ Ejb Jars:

- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the WICS_Connector_ID module
* WICSConnector bean.
- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the Connector_ID module.
* MQWFConnector bean
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3. Right-click the <SessionBeanName> node in the tree and select

Modify from the shortcut menu that appears.

Q

{1 Applications
©|BM_WE1_Monitor
® -0 EjbJars
Q- Connector_|D
{2 Entity Beans
Q-] Session Beans
MEWF Conneck=

@ Monitor b

{1 Entity Beans | Saue

® ] Session Beal Cancel
ClaanupAgent

Clientagent Expand
DEBridge Collapse
EventProcass] Properties ¥

MolificalionAge  pogee )
O WMQI_Connector_ID

{] Entity Beans | Help

Select the +RunAs tab on the right.
Click Modify All.

Type | Role | Inteface | MWethod | Parameters
Callar Horne create
Callar Home gelEJEMeta. .
Callar Horne getHomeH..
Caller Horme rEmove javalang 0.
Callar Hiorne FRFTIONE Javaa|bH...
Caller Rermole crealaMonil . com holosa.
Callar Rernala infializeMo. . com hologo.
Caller Rermole crealaEvent.. com holoso.
Callar Rernola infializedEy.. com hologo.
Callar Ramole IsManitarD. =

il frt
e e
Mo | oty all. | Vew. |

The Modify all runas permissions dialog box appears.

EH-:--:hlr all Funas permisshons

| Cancel |

6. Select Server from the Type combo box.

© Copyright IBM Corp. 2002, 2003

153



7. Click OK. The Type column will display Server for all Runas
Permissions.

9. In the Environment tab add the EJB environment parameters as the
following table:
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Property Name / EJB Name:

< | NotificationAgent
< | WMQIConnector
< | WICSConnector

<« | ClientAgent
<« | CleanupAgent

< | EventProcessor
< | DBBridge

monitor.db.schema

< | < | MQWFConnector

monitor.db.eqSchema

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modellndexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

monitor.db.tablespaces.processDataTables

monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalLob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDatalLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

NS N N N N N N N N I N I N N N N NS N BN B NE AR

monitor.db.tablespaces.mbDetailLob

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqlndexes

monitor.db.tablespaces.conDetailDatalLob

RN ERNE RN

monitor.db.tablespaces.defaultTablespace v

monitor.wmagi.enabled v v

monitor.wics.enabled v v

monitor.mqwf.enabled v v

monitor.security.mode v
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monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

monitor.mqwf.locator

monitor.mqwf.agent

monitor.mqwf.system

monitor.mqwf.sysGroup

NI BN BN AN AN B N BN ERNE RN

SESS S

monitor.mqgwf.encoding

v

The following table provides the description of each parameter.

Parameter Name

Type

Value Description

monitor.db.schema

java.lang.String

The Monitor Database Schema. The default value is
WFM. This property must not has null value.

monitor.db.eqSchema

java.lang.String

The MQSeries Workflow Database (Event Queue
Database) Schema. The default value is FMC. This
property must not has null value.

monitor.mqwf.enabled

java.lang.String

Type True if you are using MQ Workflow as your engine
or False otherwise.

monitor.wmgqi.enabled

java.lang.String

Type True if you are using WMQI as your engine or False
otherwise.

monitor.wics.enabled

java.lang.String

Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode

java.lang.String

The applied security mode:

* Type MQ for MQ Workflow security mode if you are
using MQ Workflow as your engine.

» Type LDAP for LDAP security mode or Local for local
security mode if you are only using WMQI as your
engine.

monitor.security.ldap.url

java.lang.String

The LDAP Server URL and port number (for example
Idap:/lldapsrvr:389/).

This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.

monitor.security.ldap.dn

java.lang.String

A Distinguished Name (DN) for an LDAP Server autho-
rized user that will be used for logging in to this LDAP
Server, and performing the search in the LDAP users'
tree.

This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.
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monitor.security.ldap.password

java.lang.String

The password of the defined User DN. This parameter is
added only if you are only using WMQI as your engine
with LDAP security mode.

monitor.security.ldap.naming.attr

java.lang.String

The name of the prefix that precedes the user ID in the
LDAP Server database (i.e. CN, UID,...etc). The value of
this parameter varies between the different types of
LDAP Servers. This parameter is added only if you are
only using WMQI as your engine with LDAP security
mode.

monitor.security.ldap.root

java.lang.String

The starting point in the LDAP tree from which the query
will start searching for the full DN of the given user ID.
This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.

monitor.security.ldap.dn.attr.id

java.lang.String

The name of the Distinguished Name attribute ID (for
example distinguishedName, entrydn ...etc. This value is
case sensitive). This parameter is added only if you are
only using WMQI as your engine with LDAP security
mode.

monitor.mqwf.locator

String

The MQSeries Workflow Locator Policy that is used to
locate the MQSeries Workflow Java Agent. This property
can have one of the following values: LOC, RMI, OSA,
IOR, COS, or JNDI. The default value is LOC (Local
Locator Policy)

monitor.mqwf.agent

java.lang.String

The MQSeries Workflow Agent's Name

monitor.mqwf.system

java.lang.String

The MQSeries Workflow System's Name

monitor.mqwf.sysGroup

java.lang.String

The MQSeries Workflow System Group's Name

monitor.mqwf.encoding

java.lang.String

The MQSeries Workflow Database encoding. (This
property must be set if the MQ Workflow Database
encoding is different from the Monitor Server machine
encoding)

In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define

© Copyright IBM Corp. 2002, 2003

157




this property then the database user default TableSpace will be used as

the default TableSpace.
Parameter Name Type | Value Description
monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database
Administration tables.
monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database
Administration indexes.
monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static
model tables.
monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static
model indexes.
monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database
Security tables.
monitor.db.tablespaces.securitylndexes String | TableSpace name of the Monitor Database
Security indexes.
monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.
monitor.db.tablespaces.processDatal.ob String | TableSpace name of the Monitor Database
Process Data LOB.
monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.
monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.
monitor.db.tablespaces.eventDatalLob String | TableSpace name of the Monitor Database Event
Data LOB.
monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.
monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.
monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .
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monitor.db.tablespaces.eqlndexes String | TableSpace name of the MQSeries Workflow

Database Event Queue indexes.

monitor.db.tablespaces.conDetailDatalLob String | TableSpace name of the MQSeries Workflow

Database Configuration Detail Data LOB

monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used

for any tables or indexes category that has not
been assigned to a specific TableSpace.

Important Note: In MQ Workflow, a default configuration must be
defined even if the entered System Group and System belong to a
different configuration.

To add each of these parameters do the following:

- Click Add. The Add environment entry dialog box appears.
x|

Entry nams

Ty
| jenva. kang. String -
Wil

Dasciigion

I¥|

[4]

- Type the parameter name in the Entry Name box.

- Select the parameter type from the Type drop down list.
- Type the parameter value in the Value box.
- Click OK.

© Copyright IBM Corp. 2002, 2003 159




10. Right-click the <SessionBeanName> node and select Save from the
shortcut menu.

® [ EjbJars
@ Connectar_ID
[ Enfity Beans
@ 1 Sesslon Beans
MGWE Ciipastas

FAnlafy

& Monitar

[ Entity Beal s

@ [ SessianB Cancel

CleanupAg
Cligntagen]  Expand
EBE'I'SQB Cillapsn

waiProce operties

Hotification| Br by

B WMQI_Connechor

] Entity Beat  Help

Hefrosh

5.1.2.4 Adjusting the BootstrapServlet Parameter
Add the monitor.indirectEjbCall parameter to the BootstrapServlet parameters
list:

1. Expand the Applications tree and select IBM_WBI_Monitor \ Web
Apps \ MonitorService \ Web Components \ BootstrapServiet

2. Right-click the BootstrapServilet node and select Modify from the
shortcut menu that appears.

® [ Applications
@ 1BM_WEI_Monitor
&[] EjbJars
% [0 Webbpps
& MonitorClient
© MonitorSenvice
@ 0 Web Componants

Bootstraps 1
3 security ¢

[ Application Clients)  saue
Cancel

4

 General | lcc
Initialization
N

3. Select the Parameters tab on the right.
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4. Click Add. The Add initialization parameter dialog box appears.

Endd initialization parameter X|

Hame

| ronitarindirectEjbCall |

Yalue

| htp:indieh Serverfamelimonitorsemvice/BootstrapServlet |

Description

| »

1]

OK Cancel Help

Type monitor.indirectEjbCall in the Name field.

Type http://[<WebServerName><MonitorServiceWebPath>/
BootstrapServiet in the Value field.

Click OK.

Right-click the BoorstapServilet node and select Save from the shortcut
menu.

& [0 Applications
@ 1BM_WEI_Monitar
&[] EjbJars
@ [ WebApps
& MonitarClient
¢ MonitorSenice
® 7 Web Components

3 5o Modify

Expani
Collapse
Properties L]

Riefresh

Help
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5.1.2.5 Deploying and Exporting the Modified Monitor
Enterprise Archive (.ear) File

1. Right-click the IBM_WBI_Monitor node in the Applications tree and
select Deploy from the shortcut menu that appears.

P -0 Applications
@ |BMW_WHIL Monilor

¢ Modity

2. Wait for the confirmation message that notifies you that the Application
IBM_WBI_Monitor was deployed appears in the Status Bar.

3. Select Selected > Export from the menu.

E - Application Assembly Tool for z/05 and 05390

File §EIE£:tEd| Build “iew Edit Filter Option
: * . * Mﬂdif_v F<l h .O t q
— 1 M Delete CtlDelete
e B
§ s
Export... E
BANS
Go to

nnitnrfnant

The Export Application dialog box appears.
x|

Entes ihe EAR file path name prefic

| O wWBIMonitord 24\servenservermonitord |ear | Choose.. |

[¥  WabSphere for 205 Version 4.0 compatible
[ox ]  Concel | | tew |

4. Make sure that the WebSphere for z/OS Version 4.0 compatible
check box is selected.
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5. Enter the path and the name of the modified Monitor Enterprise Archive
(.ear) file, and then click OK.

(25, | I1tis preferred to export the file with a new name (example:

o monitord.ear) so that to distinguish it from the original file.
However, if you want to replace the original file, you can click
Choose and select the path and the name of the original file to
replace it.

The modified Monitor Enterprise Archive (.ear) file will be saved with the
specified name in the selected path.

5.1.3 Deploying IBM WBI Monitor

After modifying the Monitor Enterprise Archive (.ear) file, you are now ready to
start the IBM WBI Monitor deployment. The deployment steps are performed
using the Administration Tool of IBM WebSphere Application Server for z/OS
and OS/390, which is installed on a client machine that has Windows, AlX, or
Solaris as its operating system and connected to the S390 Mainframe where
the IBM WebSphere Application Server for z/OS and OS/390 is installed over a
LAN/WAN TCP/IP connection.

The following sections describe in detail the deployment steps of the IBM WBI
Monitor on IBM WebSphere Application Server for z/OS and OS/390.

5.1.3.1 Adding a New Conversation for the Monitor
Application Server

1. Start the Administration Tool of IBM WebSphere Application Server for z/
OS and 0S/390.

The Login dialog box appears

(FLogin x|
II_{H:IT.‘-I[IJFI SENET |H name
|og390:2
Pt
B =
Userid
[CEADMIMN
Password
P
OK Options... Cancel Hielja

2. Enter the name (or the IP address), port number, user Id, and password
of the WebSphere Server for z/OS and OS/390 on which you will deploy
the Monitor in the corresponding fields and then click OK.
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The Administration Tool's main window opens.

[ st b e e — aliting
[ | Jeleitih | e | Qplisie . iy

T Converatem P
=5 walait it
= Trwdeli
&= 5 SDCARNT Sarwef Dufindan

3. Right click the Conversations node in the left hand tree and select Add
from the shortcut menu that appears. The right area will display the
properties of the new conversation to let you enter the values of the
required properties.

i VebSphere Application Server Tor 205 and 05330 Admintstraton

Fle Selected Bulld View Options Help
‘'D® BX =909 H.:iv%

¢ ] Conversations
'E"g tradei0
&%) Tradedi

25 BBOASRZ Server Definition

Cormer sations

Comsersatihon name:

Cormsersation description:

4. Enter <MonitorConversation> in the Conversation name field.

5. If you want to add a description for this new conversation, then enter the
description text in the Conversation description text box.

6. Click the Save button in the toolbar to save the new conversation.
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5.1.3.2 Creating the Monitor J2EE Resource

=k _| If a previous J2EE Resource has been created before and already

& points to the same DB2 location where the Monitor and
EventQueue databases exist, then you can use it instead of
creating a new J2EE Resource. In this case you don’t need to
perform the steps in this section.

[=&_| Important Note: Make sure that the J2EE Resource (either the new

] J2EE Resource that you will create or the one that has been
created before and you will use) must have JDBC Connection
Pooling enabled.

To create a new J2EE Resource:

1. Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEResources.

2. Right click J2EE Resources and select Add from the shortcut menu
that appears. The properties of the new J2EE Resource appear on the
right.

| it b s b o D T altin

[ U —
W P - ® figy
i * IVETLEDanY
T iy
L Byspianm
% POCT

- SIS ervery

- Sarvamn
- -
# il Ressurtes
= pROLEED Ea0 WP AEROURCE
= iy Santen
- Logecal Beeswrcs Mappangs
& 5 maigeatel i il K
:?T'"'ql L i i it v [l T a8 vy
y Whlaie
= & SRCATED Sereer Cafindan s L 1 bt e
e e 2 O S ela e

T ILEJ Bt PR bimk

3. Type Monitor in the J2EE Resource name field.
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4. Select DB2Datasource from the J2EE Resource type combo box.
Click the Save button in the toolbar.

Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEResources > Monitor > J2EE Resource Instances.

7. Right click the J2EE Resource Instances and select Add from the
shortcut menu that appears. The properties of the new J2EE Resource
Instance appear on the right.
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Type Monitor in the Datasource instance name field.

Type the DB2 Location name (the DB2 Subsystem name) on which the
Event Queue and the Monitor databases exist in the Location Name
field.

10. Click the Save button in the toolbar.

5.1.3.3 Installing the New Monitor J2EE Application

1. Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName>.

2. Right click the <MonitorJ2EEServerName> and select Install J2EE
application from the shortcut menu that appears.
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The Install J2EE application on Server: <J2EEServerName> dialog
box appears.

7 vstall JZEE application on Sorver: BEOASRZ x|
EAR Filiaine | CMemgLmontord sar | | Browse EARFile.. |
Destination FTP Senver | 0539052 | I Passbe FTP

[ ok |  Cancel | | hem |

3. Enter the path and the name of the Monitor Enterprise Archive (.ear) file
that you have modified with the required parameters in the EAR
Filename field.

- You can click Browse EAR File to select the ear file name and path.

4. Keep the Destination FTP Server field and the Passive FTP check box
with there default settings.

5. Click OK. A message appears to tell you that the application contains
references to non existent resources.

6. Click OK. The Reference and Resource Resolution dialog box
appears.

T peference and Resource Resolution
[ 1BM_WEBI_Maonitar
®- [ monitar
& Clientagent
& cleanupagent
& totilcationAgent
& ewenProcessor
' DEBridge
& [ Conneclor_ID
& mowr Connector
& [ WMal_Connector_iD e
& GG onnecior DEE
&= [ monitorclient_VWebApp jar
& [ monitorservice_WebApp jar |

comholpsobumonsionserver.efs, Chent Ageni Bean

ence | ¥ JZEE Resource
Hame | Typa | J2EE Resource
tl.‘lht‘.-'fﬂl.'lliﬂ orDatasSource |.r.rax.s-:|!.|}.«t<1*.-iuur CE

|23 EJB .3 Ra

7. Expand the IBM_WBI_Monitor tree and select Monitor > ClientAgent.
And do the following:

- Select the J2EE Resource tab and do the following:
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* Click the row cell of the J2EE Resource column that contain jdbc/
MonitorDataSource in the Name cell, and select Monitor J2EE
Resource from the drop down list.

JZEE Reszource
! bl
HEBOASREZ_EJB_|
IBMHttpSession
Monitor

- Select the EJB tab and do the following:

= Reference and Resource Resolution

[ 1B _YWBI_saonitor
& = Monitar

com.holnsolumaoniton senverajbs. Cliont AgentBean
.9 Clientagent

JEm | Y Reference |, JZEE Resource |
& Clzanupagent |

& votincatonagent Home interface Mami;

& EventProcessor com.holosofe monitorapl.clientapl ClientAgeniHome
& oesridge Remote Inferface Name;
& [ Connector_ID com holosof manitorapl clientapl ClientAoent
& MowFConnecior
@ I WMOI_Connactar_ID T!'H:
& viMciConnecior SasSii
& =3 monitorclient_WebaApp.jar JNDI Path
& [ monitorsanica_Webappjar || [s
JHD N

| l:.."l:l-;'r.l.h.lzl-|.l::|.5.l:lf[ mandarapl clientapl ¢|!-E'HDRQEFI1H ome ] I
| Set Default JNDI Path & Name [original] |

|- SHI-FSSAFEDBIM.HIIHPME_HMIIM]_I

Help

* Click Set Default JNDI Path & Name to restore the default JNDI
path and name.

®

Repeat the previous step for the CleanupAgent, NotificationAgent,
EventProcessor, and DBBridge nodes under the Monitor node. Also
repeat the steps for the WMQIConnector node under the
WMQI_Connector_ID node and for the MQWFConnector node under
the Connector_ID node.

- For the MQWFConnector node select the Monitor J2EE Resource
from the drop down list for all existing rows in the table (three rows).

Select IBM_WBI_Monitor > monitorclient_WebApp.jar >
monitorclient_WebApp from the tree and do the following:

- Select the EJB tab and do the following:

©
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¥ Reference and Resource Resolu x|
[ IBM_WEI_Monitor

& & Monitor
& crientagent
ﬂ CleanupAgent
..ﬂ MotificationAgent
& EventProcessor com.ibm w390 we container RemoteWebAppHome
& pBBridge Remote Interface Name:
9 m';”"e”@ rD com,ibm ws 390 we container RemoteWebipp
MGWF Connechor
& B WMol_Connector_|D Type:
& Wi Connector Eession
& ] monilorclient_WebApp jar JNDI Path:
& moniiorclient_WebApp | MVS034BB0ASRINBM_WEI_Monitormonitorclient_WebAppimonitore|
@[] monitarserdce_Wabapp ja
3 manitarsemvice_WabApp. jar JND! Mome:
[ |
| Set Default JNDI Path & Name [original] |
| Set HFS SAFE Default JNDI Path & Name [new] |
|_Hew | | sawe | [ cance

* Click Set Default JNDI Path & Name to restore the default JNDI
path and name.

10. Repeat the previous step for the IBM_WBI_Monitor >
monitorservice_WebApp.jar > monitorservice_WebApp

11. Click OK and wait until the new J2EE application is installed and
deployed.

5.1.3.4 Adding the MQ Workflow Classpath and Library
Path

The last step you need to do before committing and activating the Monitor
conversation is to add the MQ Workflow Classpath and Library path in order to
be able to communicate with MQ Workflow. To do this:

1. Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName>.

2. Right click the <MonitorJ2EEServerName> and select Modify from the
shortcut menu that appears.

The properties of the new J2EE Server appear on the right.
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> Environment Editing Dialog x|
Level  Server = X
¥ Add 170000 Delete
Name | CLASSPATH -|
Variable Valug

Tuslppido2idb2T1 Diclassesidb 2j2classes Zip:
Nocalfre eV 23 2 2 binava 33200 meojaot jar

Help | | ok |

3. Scroll the Properties page until you find the Environment Variable

List.
Emvironment variable list:
Level | Marne | Yalue

__1|SRY BEOC_HTTP_PORT go8v =
__JSRY BEOC_SKIP_DESTROY... [YES g
__3SRY Syl _LOGFILE ftmpdwbijem.log ||
__d|SRY DBE2SQLIPROPERTIES  |letcfdbZsgljjdbe. properie...
__5SRY JAva ERTRA_OPTIONS  [-Dmonitor.security. made...
__BSRY LIBFATH fustlppidh 2idb 271 Odlikcia...
__7SRY CLASEFATH fuslppidh2idh 271 0clas...
__B|SPX BECLAMG ERUS =

4. Double click the CLASSPATH environment variable. The Environment
Editing Dialog appears.

170

5. In the Variable Value text box do the following:

- Type a semicolon at the end of the last line if it is not ended with a one
and then press Enter to add a new line.

- In the new line, type the path and name of the MQ Workflow Library file
named fmcojagt.jar which is located in <MQ>/bin/java3320 if you have
IBM MQSeries Workflow v3.3.2 or in <MQ>/bin/java3400 if you have
IBM WebSphere MQ Workflow v3.4.

[z5 | The added line should not end with semicolon if it is the last line in
¥ the box. Otherwise, you should type a semicolon at the end of this

added line.

- Click OK.

IBM WBI Monitor - Deployment Guide



6. In the Environment Variable List, double click the LIBPATH environment
variable. The Environment Editing Dialog appears.

I Environment Editing Dialog x|
: =l X
Level S
evel  Server e ! Detets
Name | LIBPATH - |

‘ariable Value

fusrippidb2idb2 71 Odity;
Tusrippdavardi 2bin:
fusriipphavaldi Jhinfclassic:
fusipphtebSpheranit;
NocalffmeiMEWWE 3322

| vep | on |

7. In the Variable Value text box do the following:

- Type a semicolon at the end of the last line if it is not ended with a one
and then press Enter to add a new line.

- In the new line, type the MQ Workflow installation path.

[z%_[ The added line should not end with semicolon if it is the last line in
i the box. Otherwise, you should type a semicolon at the end of this
added line.

- Click OK. Then click the Save button in the toolbar.

5.1.3.5 Committing and Activating the New Conversation

Now you can start committing and activating the Monitor conversation you have
created. In order to do this:

1. Right click <MonitorConversation> in the Conversations tree and
select Commit from the shortcut menu.

Click OK on the confirmation message.

Wait until the Commit task is finished.

B

Right click <MonitorConversation> in the Conversations tree and
select Complete from the shortcut menu. A sub menu appears

Select All tasks from the sub menu.
Click OK on the confirmation message.

Wait until the Complete task is finished.

© N o o

Right click <MonitorConversation> in the Conversations tree and
select Activate from the shortcut menu. A sub menu appears

9. Click OK on the confirmation message.
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10. Wait until the Activate task is finished. The Status bar will display a
confirmation message that the conversation was activated.

5.1.3.6 Starting the WebServer and the Monitor
Application

Now the IBM WBI Monitor Application Server deployment procedure has
finished. You should now do these two steps in order to finalize and complete
the deployment:

1. Start the Web Server that IBM WebSphere use (e.g. IBM HTTP Server).
If the Web Server was started then stop and restart it again.

2. Start the newly deployed Monitor Application Server.

5.1.4 Finalize the Monitor Server Deployment

172

5.1.4.1 Initialize the Monitor Database

Run a Web browser (such as MS Internet Explorer)
2. Type the following URL:

http://<WebServerName><WebPath>/admin

(eg. http://monitorsrvr/monitor/admin)

The Login Page appears

3. Enter the User ID and Password of a valid user. (Please refer to the WBI
Monitor Administration Guide for detailed information about the WBI
Monitor authentication and security options). The Administration Utility
Web page opens.

4. Initialize the Monitor Database tables by clicking the Create Database
button that exists in the Monitor Database Setup page. The initialized
tables must have been created previously using the DDL files named
monitorCreate.sql and eqCreate.sql that are located in the <Monitor>/
server/docs/ddl folder. Please refer to the section entitled Configure the
Database Server above in this chapter for details about configuring the
database server and creating the database tables.

5. Close the browser.

5.1.4.2 Importing Organization XML Files

You have to import the required organization XML files to the WBI Monitor
database in order to complete the deployment instructions.

Please refer to the WBI Monitor Administration Guide for the detailed
instructions of importing organization XML files.

IBM WBI Monitor - Deployment Guide



5.2 WBI Monitor Server Removal

This section is used to completely un-deploy the Monitor Server. To completely
un-deploy the Monitor perform the following steps:

1.

10.

1.
12.
13.

14.
15.
16.
17.

Start the Administration Tool of IBM WebSphere Application Server for z/
OS and 0S/390.

The Login dialog box appears

Enter the name (or the IP address), port number, user Id, and password
of the WebSphere Server for z/OS and OS/390 on which you will deploy
the Monitor in the corresponding fields and then click OK.

The Administration Tool's main window opens.

Right click the Conversations node in the left hand tree and select Add
from the shortcut menu that appears.

The right area will display the properties of the new conversation to let
you enter the values of the required properties.

Enter <MonitorConversation> in the Conversation name field.

If you want to add a description for this new conversation, then enter the
description text in the Conversation description text box.

Click the Save button in the toolbar to save the new conversation.

Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName> > J2EEApplications >
IBM_WBI_Monitor.

Click the Delete button in the Toolbar (identified by a red X), or select
Selected > Delete from the menu, or right click IBM_WBI_Monitor and
select Delete from the shortcut menu that appears. A confirmation
message appears.

Accept the confirmation message. a red cross will appear next to
IBM_WBI_Monitor in the tree.

Right click <MonitorConversation> in the Conversations tree and
select Commit from the shortcut menu.

Click OK on the confirmation message.
Wait until the Commit task is finished.

Right click <MonitorConversation> in the Conversations tree and
select Complete from the shortcut menu. A sub menu appears

Select All tasks from the sub menu.
Click OK on the confirmation message.
Wait until the Complete task is finished.

Right click <MonitorConversation> in the Conversations tree and
select Activate from the shortcut menu. A sub menu appears
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18. Click OK on the confirmation message.

19. Wait until the Activate task is finished. The Status bar will display a
confirmation message that the conversation was activated.
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PART

1V

Upgrading your Existing
Version of WBI Monitor to
the Recent Version
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Chapter 6: Upgrading your Existing
Version of WBI Monitor to
the Recent Version

This chapter contains the required information about upgrading your existing
version of WBI Monitor to the recent version. This includes replacing the
deployed version of WBI Monitor application on WebSphere Application Server
with the new version, as well as upgrading the existing Monitor database that
already contains data stored in its tables to adhere to the latest modification in
the current version of WBI Monitor 4.2.4 (Fix Pack1) database, and migrate the
stored data to the upgraded database.

The WBI Monitor upgrade must be performed in the following sequence:

1. Stop the MQ Workflow Engine (if you are using MQ Workflow as one of
the runtime engines).

2. Un-deploy the existing version of WBI Monitor Server completely from
the WebSphere Application Server. On Windows, AlIX and Solaris
platform, you can perform the un-deployment either automatically or
manually. On z/OS and 0OS/390 platforms you can only perform the un-
deployment manually.

[z&_| Refer to the section entitied WBI Monitor Server Un-Deployment in

=" | Part2- Chapter 2: WBI Monitor Installation of this guide for the
detailed steps of automatic un-deployment of WBI Monitor Server.
Refer also to the section with the same title in Appendix A: and
Appendix B in Part 2 of this guide for the detailed steps of the
manual un-deployment of WBI Monitor Server. Refer to the
section entitled IBM WBI Monitor Deployment on 0S/390 and z/OS
Platforms in Part 3 of this guide for the un-deployment steps.

3. Backup your existing Monitor database and the MQ Workflow Database
(if you are using MQ Workflow as one of the runtime engines).

4. Perform the Database Migration and Upgrade after completely un-
deploying the existing deployed version of the Monitor Server. The next
section of this chapter describes how to perform the database upgrade
in detail.

5. Install the new version of WBI Monitor and Deploy the WBI Monitor
Server that belongs to the new version of WBI Monitor after completing
the upgrade and migration of the database.

© Copyright IBM Corp. 2002, 2003 177



Refer to the section entitled WBI Monitor Server Installation and

| i, | deployment in Part 2 - Chapter 2: WBI Monitor Installation of this
B guide for the detailed steps of automatic deployment of WBI
Monitor Server. Refer also to Appendix A and Appendix B in Part 2
of this guide for the detailed steps of the manual deployment of
WBI Monitor Server. Please refer to the section entitled IBM WBI
Monitor Deployment on 0S/390 and z/OS Platforms in Part 3 of
this guide for the deployment steps.
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6.1 WBI Monitor Database Migration

The database migration to WBI Monitor 4.2.4 (Fix Pack1) can be done only if
the existing database belongs to WBI Monitor version 4.2.4. If the existing
database belongs to an earlier version than v4.2.4 (version 4.2.3 and before),
then you cannot migrate the database directly to the current version. In this
case you must upgrade your existing database incrementally to version 4.2.4.
This means you must upgrade the database from each version to the next
higher version in each step. Afterwards, you can upgrade the database to the
recent version of WBI Monitor.

[z% | The database migration retains the code page of the upgraded

o database. That means if the existing database that belongs to
v4.2.4 has a specific code page (for example IBM-1252), then the
upgraded database will still have the same code page. Therefore,
if you intend to run WBI Monitor in an internationalized
environment, then you must export all tables of the WBI Monitor
schema (defaults to WFM unless changed) and import these
tables into a newly created database with UTF-8 code page before
the database migration. Please consult your Database
Administrator for information about exporting and importing data
across databases.

6.1.1 Using the Database Migration Tool

You can perform the database migration to the new version by running the WBI
Monitor Migration Tool. This tool starts by running a batch file named
migration.bat on Windows platform (or migration.sh on AlX and Solaris
platforms) that exists in the migration directory in the folder where you have
extracted the contents of the zip (or tar) file you have downloaded from the
Internet.

This batch (or shell) file needs the path and name of the database JDBC Driver
file and the path of the name of the migration properties file to be passed as
parameters when you run it.

Before you run the Migration Tool, you need to edit the migration properties file
named migration.properties that is located in migration directory in order to
adjust it default properties values to the suitable values that match your
deployment environment.

To modify the migration properties file:
1. Open the file named migration.properties with any text editor you have.

2. Select the proper JDBC driver you are using (either the DB2 driver or
Oracle driver) by removing the comment mark (#) before the line that
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contains this driver and put another comment mark before the line that
contain the unused driver.

Example:
If you are using IBM DB2 then the file should contain these lines:
# DB2 Driver
noni tor. db. dri ver=COM i bm db2. j dbc. app. DB2Dr i ver
# Oracle Driver
#moni tor. db. driver=oracl e.jdbc.driver.Oacl eDriver
If you are using Oracle then the file should contain these lines:
# DB2 Driver
#moni t or. db. dri ver=COM i bm db2. j dbc. app. DB2Dri ver
# Oracle Driver
noni tor. db. driver=oracl e.jdbc.driver. O acl eDriver

Select and adjust the proper Monitor database URL by removing the
comment mark (#) before the line that contains proper database URL
and put another comment mark before the line that contain the other
URL. If the database URL needs to be modified with a different
database name then you should modify it too (the default name is
WFMDB).

Example:
If you are using IBM DB2 then the file should contain these lines:
# Step: Get Monitor Database
#moni t or . db. url =j dbc: oracl e: t hi n: @r acl e: 1521: WFVDB
noni tor. db. url =j dbc: db2: WFVDB
If you are using Oracle then the file should contain these lines:
# Step: Get Monitor Database
nmoni tor. db. url =j dbc: oracl e: t hi n: @ERVER_| P: 1521: WFMDB
#nmoni tor . db. ur | =j dbc: db2: WFVDB

- If the Monitor Database has been created with a different name other
than the default database name (WFMDB) then you must also change
the database name in the file with the actual name of the database.

Adjust the values of the Monitor database administrator's user name,
password, database Schema and the database TableSpace name with
the actual values you are using.

Repeat steps 3 and 4 for the MQ Workflow (Event Queue) database
section to adjust the database URL, database administrator's user
name, password, database Schema and the database TableSpace
name with the actual values you are using.
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- If the Event Queue Database has been created with a different name
other than the default database name (FMCDB) then you must also
change the database name in the file with the actual name of the
database.

- If you are not using MQ Workflow as the runtime engine (that means
you are using only WMQI only), then you should comment or remove
all properties of the MQ Workflow database section in the properties
file. to comment the properties, put the comment mark (#) at the
beginning of each line in the section.

6. If you want to run the SQL statements that perform the database
migration separately, then you must remove the comment mark (#)
before the line that contains the property monitor.db.runSQL=FALSE.

[z5 | This step is mandatory if you are using IBM DB2 database on OS/
¥ 390 or z/OS platforms.

In this case you should run the appropriate .sql files that exist in the SQL
folder under the migration folder. There are three folders under the SQL
folder: DB2, Oracle, and DB20S390. Each of these folders contains the
sql files that should be run as in the following:

- For IBM DB2 database on Windows, AlX, and Solaris platforms:

* Run the files named DB2WFMDB.sql and DB2FMCDB.sql that are
located under the Migration\sq\DB?2 folder before running the
migration.bat (or the migration.sh) file.

* Run the file named DB2WFMDB-AfterJarExecution.sql that is
located under the Migration\sq\DB2 folder after running the
migration.bat (or the migration.sh) file.

- For IBM DB2 database on OS/390 and z/OS platforms:

* Run the files named DB2-OS390WFMDB.sql that is located under
the Migration\sqA\DB20S390 folder before running the
migration.bat (or the migration.sh) file.

* Run the file named DB2-OS390WFMDB-AferJarExecution.sql that
is located under the Migration\sqA\DB20S390 folder after running
the migration.bat (or the migration.sh) file.

- For Oracle database on Windows, AlX, and Solaris platforms:

* Run the files named OracleWFMDB.sql and OracleFMCDB.sql
that are located under the Migration\sq\Oracle folder before
running the migration.bat (or the migration.sh) file.

* Run the file named OracleWFMDB-AfterJarExecution.sql that is
located under the Migration\sq\DBZ2 folder after running the
migration.bat (or the migration.sh) file.

Before running these files, you should edit them in order to change the
variables named $SCHEMA$ and $TABLESPACES$ with the actual
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names of the tables schema and tablespace in each occurrence in the
files.

7. Keep the value of the property named monitor.db.version without any
change.

8. Save and close the file.

[z%_| You can save the file with a different name. In this case you should
¥ pass this new name to the migration.bat when you run it.

Important Notes:

» Make sure that the Database Users specified in the migration properties
file have enough privileges (create table, create trigger, drop table, drop
trigger, alter table, select, insert, update).

« If the database type is Oracle, make sure that the Monitor Database User
specified in the migration properties file is the owner of Monitor Schema.

* According to your stored data size in the Monitor database and the MQ
Workflow database, you may need to do the following before running the
migration:

* In Oracle Database, increase the Rollback Segment value.
* In DB2 Database, increase the Log File Size.
To run the Migration Tool:

1. From the command line, run the migration.bat (or migration.sh) with
passing the database JDBC Driver file and the path and the name of the
migration properties file as parameters

Example:
Type the following in the command line and press Enter

<ExtractionFolder>\ m grati on\ m grati on. bat
<DB2>\ bi n\j aval2\ db2j ava. zi p mi gration. properties.

2. Wait until the migration is done and the confirmation message appears.

3. If any error occurs, then restore the databases from the backup you
made before the migration, contact the WBI Monitor Support for
troubleshooting, and send them the following log file:
<Extracti onFol der >\ m grati on\ migration.log.
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Glossary
A

Activity

One of the steps that make up a process model. This
can be a program activity, process activity, or block
activity. It is also one of the building blocks that con-
stitute a process model

Activity Instance Manager
The module that handles all functions related to the
Activity instances data

Administration Sessions

The sessions Enterprise Java Beans (EJBs) are used to
administrate the Monitor server. They handle cleanup
of the Monitor database, security, and the import of
the .org modeling data from IBM WebSphere Busi-
ness Integration (WBI) Workbench™.

Administration Utility

A Web-based client that allows users to start the Event
Queue triggers and create the Monitor and Event
Queue database tables.

API, Application Programming Interface.
An interface provided by the MQ Series Workflow
manager that enables programs to request services
from the MQ Series Workflow manager. The services
are provided synchronously.

Application Server

A server-side program that runs on a distributed net-
work computer. It provides the business logic for an
application program. The application server is usually
considered as part of a three-tier application, consist-
ing of a graphical user interface, an application (busi-
ness logic) server, and a database.

Arrival Time
The timestamp at which a Job has been created.

Auto Cleanup

A Functionality in the Cleanup Ultility that allows the
application to automatically perform the process
instances and history data cleanup on a periodical
basis
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Buildtime

An MQ Series Workflow component with a graphical
user interface for creating and maintaining workflow
models, administering resources, and the system net-
work definitions.

Business Measures

Measures that allow users to evaluate the performance
of the business process while running. There are two
types of measures: those predefined by WBI Work-
bench such as cost and duration and User-defined
ones.

C

Client Sessions

The sessions Enterprise Java Beans (EJBs) handle the
communication with Monitor and Business Monitor
client.

Completion Time
The timestamp at which a Job has been completed.

Container Data
The input /output data of an activity or process.

D

Data Connectors

Connections drawn between tasks in the process dia-
gram. They determine the flow of data from an origi-
nating Task Object or Process Object to a target Task
Object or Process Object respectively.

Data Container
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Storage for the input and output data of an activity or
process. See input container and output container.

Data Structure

A named entity that consists of a set of data structure
members. Input and output containers are defined by
reference to a data structure and adopt the layout of
the referenced data structure type.

DB2

It is an IBM’s universal database management system
used by MQ Workflow and WBI Monitor to store pro-
cess models and process-relevant data.

Decisions

An internal or external environmental condition (e.g.,
an event, a specification, or a standard) that affects a
Business Process. A Decision is the question that is
asked to determine the exact set of activities during
the execution of a Process. For example, a question
might be “What type of order?” or “How will the
order be shipped?” A Decision is represented by a
Decision Object in an Activity Decision Flow Dia-
gram. There are two types of Decision Objects:
Binary and Multiple.

Delay Status

The status of the current process that is based on its
number of jobs, which are delayed as opposed to the
number of jobs, executed on time.

Yo}

Elapsed Duration
The Elapsed Duration of the Process Instance or
Activity Instance.

Entreprise Java Beans (EJBs)

Enterprise Java Beans (EJB) is an architecture for set-
ting up program components written in Java that run
on the server side of a computer network that uses the
client/server model.

Event

A message that comes from MQ Workflow to indicate
a change in the Workflow entities, and their states.
Examples of event types are ‘Process Started’, ‘Activ-
ity instance ready’, ‘Work item created’, ‘Process
completed’.
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Event Collector Triggers

They are the triggers that get installed on the MQ
Workflow database to collect the events of the con-
tainer data and store them in the Monitor Event Queue
tables to be processed later by the Monitor Engine.

Event Queue

The event queue is implemented as three database
tables in DB2 that hold the event records to be picked
up later by the Monitor Service for event processing.

Event Queue Manager

A program that handles the Event Queue filled in by
triggers; reads the event and process data, processes
events, and deletes them from the database.

F

FDL File: MQ Series Workflow Definition
Language.

The language used to exchange MQ Series Workflow
information between MQ Series Workflow system
groups. It is used by the Import and Export function of
MQ Series Workflow and contains the workflow defi-
nitions for staff, programs, data structures, and topol-
ogy. This allows non-MQ Series Workflow
components to interact with MQ Series Workflow.
See also export and import

H

Head Unit

The Organization Unit to which another Organization
Unit reports.

History Data

The high-level information calculated based on the
Instances data, which represent business measures
associated with a process

I/

IBM MQSeries Workflow
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A Workflow application developed by IBM that
allows users to automate, manage and control their
business processes.

Import

An MQ Series Workflow utility that accepts informa-
tion in the MQ Series Workflow definition language
(FDL) format and places it in an MQ Series Workflow
database.

J

Java Database Connectivity (JDBC)

The mechanism by which Java code interfaces with a
Database.

Job ID

The Workflow name of a Job or Process Instance.

M

Monitor Client

A Java client used on the enterprise network that
allows business analysts to monitor the business pro-
cesses at run time.

Monitor Data Model

A layer that grants access to the database data through
Java Database Connectivity (JDBC) of the Monitor
Server. All Monitor Database SQL statements are
encapsulated in this layer.

Monitor Databases Tables

Tables that store two types of information. The first
type is the information captured from the process
model, such as the Process Activity Flow Diagram,
that will be displayed during run time, the data associ-
ated with tasks such as User ID, Task or Activity
name, Estimated Duration, etc, and Business Mea-
sures associated with the process model. The second
type of information is that which is processed or
deduced from the run time data captured from the
Workflow database.

Monitor Engine

A module that handles the events coming from MQ
Workflow. It picks up the events, processes them, and
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stores the result in the Database for later retrieval by
the clients. Processed events are deleted after process-
ing.

Monitor Event Queue Tables

Tables that store the events together with the container
data triggers that are installed on the MQ Workflow
database.

Monitor Import Utility

A Java client that allows users to open the Organiza-
tion Folders containing the processes they want to
monitor as well as the Business measures they have
defined in WBI Workbench. They can select these
measures, and import them to the Monitor Server.

Monitor Server

The server that handles all the back-end operations of
the four User Clients. These clients control the
cleanup of the Monitor database, security, and the
import of the .org modeling data. The Monitor server
also handles the communication with user clients, the
events coming from MQ Workflow and the data
access encapsulation of the SQL statements.

Monitor User Clients

The four Monitor User Clients that allow users to take
all the necessary steps to monitor the business pro-
cesses they have developed models for, and their asso-
ciated Business Measures.

Monitoring API

A client layer that handles all the client/server com-
munication and hides the details of the monitor server
from the user clients.

N

Notification Duration

The maximum duration allowed for a process instance
before a notification is issued. This duration is
decided upon the data obtained from the Process
model that has been created using the WBI Work-
bench and imported to the Monitor Server along with
the Organization file. The value of the Notification
Duration is entered by the Modeler in WBI Work-
bench, in the Notification tab of the Task Object dia-
log box.
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Organization

An administrative unit of an enterprise. Organization
is one of the criteria that can be used to dynamically
assign activities to people. See child organization and
parent organization.

Organization Files
Files created by WBI Workbench They contain all
process and repository data the user has entered.

Organization Folders

Folders created by WBI Workbench that enclose all
process files, Organization files, and other related
files.

Organization Unit
The subdivisions in an Organization. Organization

Unit can represent departments, divisions, or sections.

Organization Unit Browser

A list that displays all imported Organization Units
into the Monitor Database to manipulate it with the
Cleanup utility

Organization Unit Manager
The name of the Manager of the selected Organization

Unit that is entered by the user in the Organization
Unit dialog box in WBI Workbench.

Overloaded

The status of the user performing the Work Items. The
user is considered overloaded when there are more
than four work items in his/her own work list. Over-
loaded status is indicated in a color code.

P

Phi

An Activity Decision Flow Diagram object outputted
from one activity and/or inputted to the next one. This
object represents the data or product that is manipu-
lated or produced during the performance of a pro-
cess. The term “Phi” is derived from the Greek letter
phi (F) because it is made up of the letter I (for input)
superimposed over an O (for output).
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Process
A set of activities in an organization that are linked
together

Process Browser

A list that displays all imported Processes into the
Monitor Database to manipulate it with the Cleanup
utility

Process Instance
An instance of a process that is currently executed.

Process Instances data
The crude data associated with each process instance
created and stored in the WBI Monitor database.

Process Version

A version of a Process model that contains some
changes from the original Process Model. The Process
may have one (the original version) or more versions,
and each version has a certain date at which this ver-
sion became valid from.

Process Diagram
A graphical representation of a process that shows the
properties of a process model.

Process Elements

The objects within an Activity Decision Flow Dia-
gram, these being Tasks, Process Objects, Decisions,
Decision Choices, Phis, External Entity/Process, Go
To Objects, Stops, and Connectors.

Process History Manager
The module that handles all functions related to the
Process history data.

Process Instance Manager
The module that handles all functions related to the
Process instances data

Process Instance or Job
An instance of a process that is currently executed.

Process Management

The MQ Workflow Run time tasks associated with
process instances. These consist of creating, starting,
suspending, resuming, terminating, restarting, and
deleting process instances.

Process Model.

A set of processes represented in a process model. The
processes are represented in graphical form in the pro-
cess diagram. The process model contains the defini-
tions for staff, programs, and data structures

IBM WBI Monitor - Deployment Guide



associated with the activities of the process. After
having translated the process model into a process
template, the process template can be executed over
and over again. Workflow model and process defini-
tion are synonyms.

Process Status
The status of a process instance.

O

Queue Controls
Controls that provide the Event Queue database with
the Control Commands: Start and Stop.

Queue Status
The Event Queue status that could be either Started or
Stopped.

R

Repository Manager
The module that handles the import of the .org and

grants access to all the build-time entities defined in
the WBI Workbench.

Role

A responsibility that is defined for staff members.
Role is one of the criteria that can be used to dynami-
cally assign activities to people.

Running Status

The status of a Process Instance based on the number
of jobs of a process currently running as opposed to
the number of jobs that are ready to run.

S

Security Manager
The module that handles authentication and authoriza-
tions of the logged-in users.

Setup Manager
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The module that handles the creation and removal of
the Monitor tables and triggers.

Starting Time
The timestamp at which a job has been started.

Sub-Process
A subordinate process impeded in another one.

T

Task

An activity in a Business Process that is manipulated
by a specified Resource. Visually, Tasks represent the
lowest level of work you can portray in a Process.

Translate
The action that converts a process model into a Run-
time process template.

Tray

A graphical container represented by a yellow con-
tainer that shows the Work Items waiting to be pro-
cessed.

U

User
The employee who belongs to one of the Organization
Units in an organization.

User ID
An alphanumeric string that uniquely identifies an
MQ Series Workflow user.

/4

WBI Monitor

WBI Monitor is a Java-based application developed to
allow users monitor and manage their business pro-
cesses that run on IBM MQ Workflow.

WBI Monitor database
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A database contains the process instances data and the
historical data

WBI Workbench

WBI Workbench is a Windows-based application
developed to allow users model, analyze, and manage
their business processes.

Web Client

An HTML client that allows users to monitor the busi-
ness processes at run-time.

WebSphere

A set of IBM Java-based tools that allow customers to
create and manage sophisticated business Web sites.
The central WebSphere tool is the WebSphere Appli-
cation Server (WAS), an application server that a cus-
tomer can use to connect Web site users with Java
applications or servlet.

Work Item

Representation of work to be done in the context of an
activity in a process instance.

Work Item Manager
The module that handles all functions related to the
Work items data.

Work Item Set Of A User

All work items assigned to a user

WorKk list

A list of work items assigned to a user and retrieved
from a workflow management system

Workflow

The sequence of activities performed in accordance
with the business processes of an enterprise.

Workflow Model

Synonym for process model

Working Duration
The Working Duration of the Process Instance or
Activity Instance
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Notices and Trademarks

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA
ADP Schedule Contract with IBM Corp.

Notices

IBM may not offer the products, services, or features discussed in this document in all
countries. Consult your local IBM representative for information on the products and services
currently available in your area. Any reference to an IBM product, program, or service is not
intended to state or imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the user’s responsibility to evaluate and
verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS”..WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions;
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the product(s)
and/or program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only
and do not in any manner serve as an endorsement of those Web sites. The materials at
those Web sites are not part of the materials for this IBM product and use of those Web sites
is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling:
(i) the exchange of information between independently created programs and other programs
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(including this one) and (ii) the mutual use of the information which has been exchanged,
should contact:

WebSphere Business Integration Lab Director
IBM RTP Laboratory

3039 Cornwallis Road

P.O. BOX 12195

Raleigh, NC 27709-2195

US.A

Such information may be available, subject to appropriate terms and conditions, including in
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program
License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available systems.
Furthermore, some measurement may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their specific
environment.

Information concerning non-IBM products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. IBM has not necessarily
tested those products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-IBM products. Questions on the capabilities of non-IBM products
should be addressed to the suppliers of those products.

This information may contain examples of data and reports used in daily business operations.
To illustrate them as completely as possible, the examples may include the names of
individuals, companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

COPYRIGHT LICENSE:

This information may contain sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the purposes
of developing, using, marketing or distributing application programs conforming to the
application programming interface for the operating platform for which the sample programs
are written. These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
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Programming interface information

Programming interface information, if provided, is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that obtain the
services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning information.
Diagnosis, modification and tuning information is provided to help you debug your application
software.

Warning: Do not use this diagnosis, modification, and tuning information as a programming
interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States or other countries, or both:

IBM MQSeries
the IBM logo WebSphere
AIX 0S/2

AIX 5L 0S/390
e-Business (Logo) z/OS
CrossWorlds Rational
DB2 RS/6000
DB2 Universal Database XDE

Lotus is a trademark of International Business Machines Corporation and Lotus Development
Corporation in the United States, other countries, or both.

Rational is a trademark of International Business Machines Corporation and Rational
Software Corporation, in the United States, other countries or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other
countries, or both.

Solaris, Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.
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